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Limited Warranty 
Vision Engraving & Routing Systems warrants that the disk 
medium upon which the product is recorded, and any 
hardware accompanying said disk(s), shall be free from 
defects in materials and workmanship -- under normal use 
and service for a period of ninety (90) days from the date of 
delivery, as evidenced by a copy of the receipt.
Vision’s entire liability and exclusive remedy as to the disk(s) or 
hardware shall be at Vision’s option -- either (a) return of the 
purchase price, or (b) replacement of the disk(s) or hardware 
that do not meet Vision’s Limited Warranty. These must be 
returned to Vision Software postage prepaid with a copy of 
the receipt.
If failure of the disk(s) or hardware has resulted from accident, 
abuse or misapplication, Vision shall have no responsibility 
to replace the disk(s) or hardware, the replacement will be 
warranted for the remainder of the original warranty period 
or thirty (30) days, whichever is longer. Other then the above 
limited warranty, Vision makes no other warranties whatsoever, 
either legal or conventional, express or implied, with respect 
to the licensed software and hardware. You are advised to 
test the licensed software thoroughly before relying on it. You 
assume the entire risk of using the licensed software. Because 
of the diversity of conditions and hardware under which the 
licensed software may be used, no warranty of merchantability 
or fitness for a particular purpose is given. Some regions do 
not allow the exclusion of implied warranties, so the above 
exclusion may not apply.

Copyright Notice
No part of this publication may be reproduced mechanically 
or electronically or in any form without the prior written 
permission of Vision. The software described in this manual is 
furnished under license and may only be used or copied in 
accordance with the terms of such license. The information in 
this manual is for informational use only, is subject to change 
without notice and should not be construed as a commitment 
by Vision Software. Vision Software assumes no responsibility or 
liability for any errors or inaccuracies that may appear in this 
document.responsibility or liability for any errors or inaccuracies 
that may appear in this document. Vision Engraving & Routing 
Systems®, Vision Express®, Vision Expert®, Vision Laser®, Vision 
Photo Laser Plus®, and Vision Pro® are registered trademarks 
of Vision Engraving & Routing SystemsWritten and designed at 
Vision Software Technology Corporation
© May 2017, Vision Engraving & Routing Systems
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Contact Information
If you have not already done so, then we ask that you perform 
registration of your package, such that Vision Tech Support 
has current information that allows them to resolve your issues 
promptly. Registration includes:

•	 Software updates
•	 Special pricing on upgrades
•	 Special pricing on other Vision Software products

Internet
www.VisionEngravers.com

E-mail
sales@VisionEngravers.com

Location
17621 N. Black Canyon Hwy.
Phoenix, AZ 85023
Tel: 1-888-637-1737

Fax: (602) 91-2288
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Quick Start
Vision 10 Software is Computer Aided Design (CAD) software 
for laser and rotary engraving systems. Vision provides leading 
edge technologies as an all-in-one package that designers 
can adapt to run their production shops efficiently. Vision 
includes tools that support a wide variety of applications, and 
development is ongoing to provide you with support for the 
latest technologies.
Vision provides simple, versatile tools that include designing 
with text, line art, and images (i.e., bitmaps). Vision also 
provides significant support for other design applications, so 
that unfinished or archived designs can be brought into Vision 
for pre-production work.

Note: The available Vision 10 Software features will vary 
according to the type of Vision package that has been 
purchased.

Note: For additional feature descriptions that are not 
contained within this User Guide, please consult the Help 
File that is provided with the Vision product.

Differences Between Rotary and Laser 
Engravers

Vision 10 Software supports a broad range of manufacturers, 
and we seek to support new machines when they become 
available. For rotary engravers, output is sent via the Engrave 
menu >> Output command.
This can also be true for laser engravers, except where the 
manufacturer has provided a printer driver for the engraver. In 
this case, output is sent via the File menu >> Print command.
The following sections highlight differences in how Vision can 
send output to rotary and laser engravers.

Overview of Rotary Engraving
(Engrave menu >> Output)
Rotary engravers use a device driver (i.e., cutter driver).

•	 In the case of engravers that are connected via the 
USB port, the device driver might be 1) provided on a 
manufacturer CD, 2) provided from the manufacturer 
web site, or 3) automatically installed when the engraver is 
connected to a Windows computer.

•	 For engravers that are connected via other types of port, 
such as serial port or Ethernet (TCP/IP), this will not involve 
installing a device driver from the manufacturer.

•	 During installation of Vision 10 Software, you will be 
prompted to install a device driver for sending output from 
Vision to the engraver.

•	 This will be in addition to any USB driver that is provided by 
the manufacturer.

•	 After Vision 10 Software installation, additional device 
drivers can installed via File menu >> Install Cutting 
Devices.

How does a design work?
•	 Once all the device drivers have been installed, 

configuration and output is performed via the Engrave 
menu.

•	 In particular, the Tool Options are where you set the feeds 
and speeds, which can be set as a general default, or for 
each type of material that you intend to work with.

•	 For a given design, tool path operations are applied to 
shapes and text, and these tool paths define the speed 
and type of operations that will be performed.
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following directory location:
C:\Vision Software\Vision 10 Software\Palettes\Engrave

Overview of Laser Engraving (device driver)
(Engrave menu >> Output)
The following applies when then manufacturer has NOT explicitly 
provided a printer driver (i.e., a device driver is being used).

•	 In the case of USB-connected engravers, the device driver 
might be 1) provided on a manufacturer CD, 2) provided 
from the manufacturer web site, or 3) automatically 
installed when the engraver is connected to a Windows 
computer.

•	 During installation of Vision 10 Software, you will be 
prompted to install a device driver for sending output from 
Vision 10 Software to the engraver. It is assumed that the 
USB driver has also been installed.

•	 After Vision 10 Software installation, additional device 
drivers can installed via menu >> Install Cutting Devices.

How does a design work?
•	 Once all the device drivers have been installed, 

configuration and output is performed via the Engrave 
menu.

•	 Engraving operations are defined by the fill color of shapes 
and text.

•	 Strokes, hairlines and thick strokes are NOT used to indicate 
a cutting operation.

•	 Instead, the Job Colors dialog lists the fill colors that have 
been applied, including the main engraving parameters 
associated with each color.

•	 Double-clicking a color in the Job Colors dialog will display 
all of its engraving parameters.

•	 Once parameters have been set in the Job Colors dialog, 
click the Save button.

Note: Changes to color parameters will be LOST unless the 
Save button is clicked.

•	 For some engravers, it can be sufficient to set cutting 
depth/pressure at the machine control panel, such that 
applying explicit tool paths to shapes is not necessary.

Overview of Laser Engraving (printer driver)
(File menu >> Print)
The following applies when the manufacturer has provided a 
printer driver.

•	 The printer driver must be installed to the Windows Control 
Panel, per the Operator’s Manual for the engraver.

•	 The printer driver might be 1) provided on a manufacturer 
CD, or 2) provided from the manufacturer web site.

•	 Within Vision 10 Software, configuration and output to the 
engraver are done via File menu >> Print.

•	 From the Print dialog, click the Setup button to access the 
Properties dialog for the printer driver, where the Power 
and Speed are set for each palette color.

How does a design work?
•	 On the workspace, these colors are applied from the Shop 

Palette, either as fill or stroke colors.
•	 For example, a shape’s fill color would indicate a raster 

operation, whereas a stroke color would indicate a cutting 
operation.

•	 Note that the Shop Palette can be set to use customized 
engraving palettes set with speed and power settings 
for specific engraver models. These preset palettes were 
installed with your Vision 10 Software product, such as the 
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Installation Checklist
If you have not already done so, then please review “Differences 
Between Rotary and Laser Engravers” on page 14.

Initial Steps
Use the following as a quick checklist when setting up Vision 
10 Software. These steps are elaborated upon in the following 
pages of this guide.
1.	 Install the device driver, or printer driver, as provided by the 

manufacturer.
2.	 Prior to beginning the Vision 10 Software installation, 

connect the Vision security dongle.
3.	 Begin the Vision 10 Software installation (e.g., from DVD), 

and proceed through the wizard installation steps.
4.	 During installation, there will be a driver installation step, 

which is in addition to any manufacturer drivers that were 
installed in step (1).

5.	 If not already done, then connect the machine that will be 
receiving the cutting data.
For proper installation of cutting knives, drill bits and loaded 
material, please consult the Operator Manual for the 
machine.
When using the machine for the first time, it is 
recommended that a sample piece of material be loaded.

6.	 Launch Vision.
7.	 When prompted to set the plate size, the Width and Height 

are typically set according to the material that has been 
loaded into the machine.

Per the following sections, continue this checklist according to your 
machine and driver type:
For Rotary Engravers
For Laser Engravers (using a printer driver)
For Laser Engravers (using a device driver)

For Rotary Engravers
Rotary engravers use the Engrave menu commands for setup 
and output.
Continuing from step (7):
8.	 Within Vision 10 Software, configure the driver settings 

for the machine (Output dialog and Engraving Defaults 
dialog).
In particular, indicate the output port to which the 
machine is connected, and confirm that the Machine 
Limits are correct.

9.	 Create objects on workspace and apply tool paths to 
these shapes.
If you intend to cut all jobs per a pressure/depth setting 
that you have made at the machine control panel, then 
you will not need to apply tool paths to your workspace 
objects.
To minimize wasted material when using the machine for 
the first time, it is recommended that small shapes be used.

10.	 Go Engrave menu >> Output to enter the Engrave Preview 
state.

11.	 In the preview, confirm the shape positions. In particular, 
there is a crosshairs marker that indicates the machine 
origin position.

12.	 To output the job, click the Engrave button (far-right of the 
Output Manager toolbar).
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For Laser Engravers (device driver)
Prior to completing the following steps, it is expected that 
you have installed the device driver as provided by the 
manufacturer.
Continuing from step (7):
8.	 Within Vision 10 Software, configure the driver settings 

for the machine (Output dialog and Engraving Defaults 
dialog).
In particular, indicate the output port to which the 
machine is connected, and confirm that the Machine 
Limits are correct.

9.	 Create shapes on the workspace and apply fill colors from 
the Shop Palette.

10.	 The Job Colors dialog will indicate the Mode that will be 
used when that shape color is output. Speed and Power 
settings can also be set.

11.	 Double-click a color within the Job Colors dialog. The 
Edit Color dialog will display additional settings that vary 
according to the Mode.

12.	 Choose Engrave menu >> Output to enter the Engrave 
Preview state.

13.	 In the preview, confirm the shape positions. In particular, 
there is a crosshairs marker that indicates the machine 
origin position.

14.	 To output the job, click the Engrave button (far-right of the 
Output Manager toolbar).

For Laser Engravers (printer driver)
Prior to completing the following steps, it is expected that 
you have installed the printer driver as provided by the 
manufacturer.
Continuing from step (7):
8.	 Within Vision 10 Software, set the default Shop Palette 

colors according to the colors that are defined within the 
printer driver.

9.	 Create shapes on workspace and apply fill and stroke 
colors. Fill colors represent raster fills, and stroke colors 
represent cut lines.

10.	 From the Print dialog, configure your printer by clicking 
Setup on the Printer tab.

11.	 On the Print dialog, click OK to send the job to the laser 
engraver. 
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documentation for more information.

Policy On Lost Or Stolen Security Devices
•	 The USB security dongle is your proof of purchase. If the 

dongle is lost or stolen, then that is equivalent to losing the 
entire software package, and a new package of Vision 10 
Software must be purchased.

•	 In the event of a damaged security device that must be 
replaced, there is a nominal fee for EXCHANGING a new 
device for the older device, where the older device must 
be reclaimed by Vision Software.

•	 This fee is waived where product is still under warranty.
•	 Regardless, it is recommended that you ensure that your 

security device is covered under your business insurance 
policy.

Temporary License Files when Replacing a USB Dongle
•	 Your USB dongle is a flash drive, such that your license files 

can be stored upon the dongle.
•	 The license files are used to confirm the features within your 

Vision Software products.
•	 If a replacement dongle is being shipped to you, then the 

expectation is that you will likewise return your previous 
dongle to us.

•	 Replacement dongles are typically issued with “temporary” 
license files that will enable you to continue using your 
Vision Software products.

•	 Temporary license files will cease working after a set 
criteria, and it is required that you return your previous 
dongle to Vision Software before the temporary license files 
expire.

•	 Once we have received your previous dongle, you will 
be provided with new “permanent” license files that will 
replace the temporary license files.

Backup Your License Files
•	 In the event of lost license files, there is a nominal 

administrative fee for issuing replacement license files.
•	 This fee is waived if the Free Support period is still active. 

Otherwise, replacement license file issues are treated as 

Installing Vision 10 Software
Vision 10 Software is provided with a small blue/white USB 
security dongle to prevent unauthorized use or pirating of the 
software. This dongle is a flash drive that plugs into a standard 
USB port of the computer, and it is transparent to other 
applications. Only Vision 10 Software is aware of the device.

Note: Before installing, please verify that you have 
administrative permissions. Otherwise, Windows will prevent 
the installation of the dongle support software.

Known Issues with USB Ports
If Vision 10 Software is not detecting the dongle, then move 
the dongle to an alternative USB port. Possible issues are:

•	 Front-mounted USB ports of your desktop computer might 
not be wired correctly. If the dongle is not detected, then 
use a back-mounted port.

•	 Where a USB hub is used, always use a powered hub. 
Non-powered hubs provide limited power per port, which 
affects many USB devices.

•	 Some USB ports provide limited power. When in doubt, 
consult the specifications provided by the computer 
manufacturer.

•	 Virtualization software can run Vision 10 Software on 
a Mac computer, provided that the dongle has been 
“associated” with Windows. Consult your virtualization 

Connect your 
security dongle 
BEFORE installing 
your Vision 10 
software!
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Tech Support requests.
•	 When Vision Software sends you new license files, it is 

important that you create backups of the license files, so 
they can be easily located when re-installing your Vision 
Software products on new equipment.

•	 In the case of the USB flash drive dongle, your license 
files can be stored on the dongle itself (instructions are 
provided alongside your new license files). When re-
installing your Vision Software products, the license files 
upon the dongle will be automatically used.

Program Installation
1.	 Connect the USB security dongle NOW.
2.	 Insert the Vision 10 Software install DVD into your CD-ROM 

drive.
3.	 Should the install wizard not automatically start, it can be 

manually started as follows:
a)	 Use the [Windows + r] keyboard shortcut to open the 

Run dialog.
b)	 Click Browse and select the setup.exe file on the DVD.
c)	 Click Open to choose the setup.exe file, and click OK.

4.	 During the installation, you will be asked to install various 
components:

•	 If you are asked to insert a CD that contains license files, 
then insert the CD, verify that the path is correct, and click 
OK.

•	 When prompted to install cutter drivers, it is recommended 
that you install drivers for your cutters at this time.

•	 For each engraver that you need, indicate their 
manufacturers, and click Next to choose specific engraver 
models from each of those manufacturers.

•	 When asked to install fonts, it is recommended that you 
install fonts at this time.

•	 Font installation will automatically detect Windows fonts 
that have been installed to the Windows Control Panel (i.e., 
TrueType, OpenType, and PostScript).

•	 For Vision Software VEF fonts, these are provided as part of 

your product install, and the VEF files will be copied to:
C:\ProgramData\Vision Software

5.	 After the installation is complete, you may be prompted to 
restart Windows.

6.	 If you were asked to insert a license disk or CD during the 
install, then eject the disk and store it in your Vision 10 
Software package.

7.	 Launch Vision 10 Software, and proceed to Customizing 
the Vision 10 Software Workspace.
Note: In addition to the Vision 10 Software product shortcut, 
there is also a limited Trial shortcut for evaluating additional 
product features.
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difficult to select amidst your overall design.

InstantReplay
Options menu >> Use InstantReplay
View menu >> Show InstantReplay
InstantReplay tracks the history of operations and special 
effects that have been applied to objects. When InstantReplay 
is ON, changes to an object will automatically update any 
operations or special effects that have been applied to that 
object.
For example, when creating badges that have variable text, 
InstantReplay will re-apply operations and special effects for 
the text of each badge.

Multiple Instance
Options menu >> Multiple Instance
This option allows you to have more than one workspace 
window open at the same time. To help manage these 
windows, the following two commands will be available under 
the File menu:

☐☐ Close – Close the current workspace window (prompt 
to save)

☐☐ Close All – Close all workspace windows

Having extra workspace windows provides a means to have 
two designs open, essentially side-by-side, such that you can 
either copy, or drag-and-drop, objects between the windows.

Workspace Rulers
Options menu >> Setup >> General Preferences
The workspace rulers can be set for either millimeters or inches.

•	 Left-click the ruler and choose the units (Fig. 2).
•	 From the General Preferences dialog, both the Units and 

Speed units (i.e., tool velocity) can be specified.

Font Point Size
When composing text, the Font Height will be expressed in the 
same units as the workspace ruler. However, the height can 
also be expressed in point size.
In Text Compose mode, click the Font Height Options button. 
Point size can be set separately for Windows Fonts (i.e., TTF, 
OTF, PostScript), versus all other supported fonts (e.g., VEF).
When the current font height is being expressed in point size, 
the Font Height Options button (Fig. 3) will indicate this in the 
form of a small dot (that is otherwise not visible on the button).

Fig. 2� - Left-click to change the units.

Fig. 3� - The Text Height Options button. The dot indicates that 
the current font height is expressed in points.

Fig. 1� - Pairs of objects, each pair on a 
separate layer.
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Sheet Page Palette
For some features, such as Nesting or Badges, the placement 
of workspace objects will be constrained by the plate size. 
When the number of such objects cannot fit, additional pages 
will be created.
Additional pages can be accessed via the Sheet Page palette 
(Fig. 5).

Plate Size
View menu >> Show Plate
Layout menu >> Plate Size
The plate size is a rectangular guide that indicates the 
available cutting area. You typically set its dimensions 
according to the loaded material.
On the Plate Size dialog (Fig. 4), set the following:

•	 Set Origin Selection according to the relative starting 
position of the engraving tool (i.e., per your Operator’s 
Manual).

•	 Set Orientation to either Portrait or Landscape.
•	 Set Current Selection to Custom.
•	 Set the Width and Height (the units here will correspond to 

the workspace ruler).

Fig. 4� - Use the Plate Size dialog to configure the on-
screen preview of the cutting area.

Fig. 5� - When your design requires additional pages for layout 
of the objects, these pages can be accessed using the Sheet 
Page palette.
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Preparing Your First Job
As previously mentioned in the introductory sections, sending 
output to your engraver can vary according to whether it is a 
rotary or laser engraver, and laser engravers can further vary 
according to whether they require a printer driver, versus that 
of a device driver.
Of the following three sections, each is tailored to one of these 
output scenarios. Choose the section that applies to your type 
of engraver, and complete the job preparation as a means 
to confirm that Vision 10 Software is communicating with your 
engraver.

Preparing a Rotary Engraving Job
The following procedure describes how to configure Vision 10 
Software for a rotary engraving job. We will begin by adjusting 
the machine settings within Vision 10 Software, creating a 
design that has a tool path for engraving, previewing how that 
design will appear before output, and then sending the job to 
be cut.

Launch Vision 10 Software
Our initial task is to configure the Output dialog, which includes 
configuration of the Engraving Defaults dialog.
1.	 From the Windows Start menu, launch Vision 10 Software.
2.	 By default, the Plate Size dialog will query for the size of 

your engraving bed. 
Typically, the Width and Height are set according to the 
Machine Limits of your engraver.
These settings can be modified later using Layout menu >> 
Plate Size.

Engraving Defaults
3.	 From the Engrave menu, choose Engraving Defaults. The 

Output dialog will open (Fig. 6).
a)	 Verify that the Selected driver is set to your engraver.
b)	 Set the Tool drop-list to indicate the loaded tool.

The options will vary according to your engraver 
choice.
Where shapes will be cut with more than one pass (i.e., 
cutting to progressive depths), the Tool setting should 

Fig. 6� - Start by setting default parameters in the 
Output dialog, such as Tool and Selected Driver.
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be “Multiple Pass” or “Router” (depending on the 
machine model).

c)	 If your workflow involves two-or-more tools that must be 
manually swapped out between passes, then tick the 
Engrave by Color option (Fig. 7).
It is expected that you have differentiated the tool 
paths according to their assigned colors.
Before each engraving pass, the Filter by Color dialog 
will prompt you to choose which tool path operation to 
perform.

d)	 When multiple objects are output in the same 
engraving pass, the default is to engrave them in the 
order of creation (i.e., database order).
Ticking the Sort option will enable prompts that allow 
you to change the sort order (prior to job output).
Your chosen sort method will depend upon what you 
believe is best for your engraver, and the composition 
of your design.
Possible sort methods could include giving priority to 1) 
the object that is closest to the current tool position, 2) 
objects that are arranged horizontally/vertically, 3) the 
object sizes, etc.

e)	 For the Engrave setting (Fig. 8), choose between Page 
and Sign Plate, which are applied as follows:

☐☐ Page: Cutting will commence at the machine’s 
origin point. This is useful when positioning a shape 
that needs to be cut at a specific location.

☐☐ Sign Plate: Shapes will be cut with respect to their 
relative positions within the sign plate.

Ticking the Selected checkbox will require that you 
explicitly select objects prior to sending output.

Fig. 7� - Engraving by color allows you to engrave 
specific portions of your design in isolation (e.g., 
when different tools are required for each 
operation).
The available sorting controls will vary according 
to whether tool paths are enabled.

Fig. 8� - Typically, you will want to restrict valid output objects to 
those that are on the sign plate, and which are selected.
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4.	 The Output Tool Paths checkbox will probably be enabled 
by default. If so, then clear the checkbox.
At this point, if you have decided that objects should be 
cut according to a depth/pressure setting made at the 
engraver control panel, then you do not need to output 
tool paths, and you can proceed to step (5).

a)	 With the Output Tool Paths checkbox clear, click the 
option to tick it. The Tool Path Options dialog will open 
(Fig. 9).

b)	 Click the Output Tool Paths option. Enabling this option 
indicates that the tool paths will be previewed in the 
Engrave Preview state.

c)	 Clear the “Also Cut Contour Paths” option. If this option 
were checked, then all objects (aside from tool paths) 
will be viewed as contour cutting paths in the Engrave 
Preview state. By disabling this option, only tool paths 
will be previewed in the Engrave Preview state.

d)	 Click OK to close the Tool Path Options dialog. The view 
will return to the Output dialog.

5.	 Click Save Default to confirm your changes.

Tool Options
6.	 Click the Tool Options button.
7.	 The Tool Options dialog (Fig. 10) is used to set the feeds and 

speeds that will be used with your machine.
Where your engraver supports more-than-one tool type, 
these settings can be customized for each tool type.
These settings can also be customized for different material 
types.

8.	 Click OK to close the Tool Options dialog.

Fig. 9� - The Tool Path Options dialog is used 
to enable the creation of tool paths, or to 
automatically apply a default tool path to objects.

Fig. 10� - The tool options vary according the engraver model. Set 
these options according to what is recommended for the given 
tool, and the loaded material.
Note that your Operator Manual will provide specific information 
about how these options should be set for your engraver model.
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Machine Limits
9.	 From the Output dialog, click the Setup button.

10.	 The Engraver Setup dialog will open.
11.	 On the Engraver tab, confirm that the Machine Limits do 

not exceed the actual limits of the engraver (Fig. 11).

Origin and End Point
12.	 Set the Origin and End Point according to where you 

want the machine to start and finish each job. You should 
set these according to the type of work that you are 
performing (Fig. 12-14).
We have provided you with default settings that will 
generally work for the majority of hardware setups, though 
you should verify these settings in the Operator Manual 
provided with your engraver.

Fig. 11� - Confirm that the Machine Limits are correct for 
your engraver. Also, click the Notes button to review port 
configuration comments that are specific to your engraver.

Fig. 12� - Plotter or Cutter: This arrangement is typical 
when a roll of media is fed through the machine.

Plotter or Cutter

(0, 0)

Direction of
media

"Lower-right"

"Lower-left"

"Lower-right"

"Lower-left"

Fig. 13� - Engraver: This arrangement is typical when 
the piece of material affixed to the table, and a 
gantry passes over the material with a cutting tool.
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Engraving
Table
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"Upper-left"
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Fig. 14� - Router: This arrangement is typical when the 
piece of material is affixed to the table, and a gantry 
passes over the material with a machining tool.
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(0, 0)

Routing
Table

"Lower-left"

"Upper-left"
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Port Configuration
13.	 Click the Notes button, and review the configuration 

comments. These comments will provide you with specific 
advice as to what port configuration settings should be 
applied.

14.	 Click the Port tab (Fig. 15).
15.	 For the Method, you have two options:

☐☐ Direct to port : Output jobs directly from Vision 10 
Software to the Port location that you have set.
For this method, proceed to “Direct to Port Setup” on 
page 40.

☐☐ Use Production Spooler : Output jobs from Vision 10 
Software to the Production Spooler queue, which can 
collect multiple jobs. For this option, the Port location 
must be set within the Production Spooler.
For this method, proceed to “Production Spooler Setup” 
on page 38.

Production Spooler Setup
The Production Spooler is a separate application that was installed 
alongside your Vision 10 Software product.

16.	 From the Windows Start menu, launch Production Spooler.
The Production Spooler must be active, so that Vision 10 
Software can detect it.

17.	 In Vision 10 Software, the Engraver Setup dialog has a Port 
tab.

18.	 On the Port tab, click the Use Production Spooler option.
This will hide the Port location controls, since the port be 
configured within the Production Spooler.

19.	 Click the Add button (Fig. 15), and Vision 10 Software will 
locate your Production Spooler application.
If you have two-or-more networked computers that 
each have a Production Spooler, then each spooler is 
differentiated according to the computer name.

20.	 Choose the Production Spooler that you want to use, and 
click OK, and the Use Production Spooler drop-list will be 
updated.

21.	 From the drop-list, choose the queue that will receive jobs.
22.	 In Production Spooler, the port can now be configured:

Fig. 15� - There can potentially be other Production Spooler 
queues on your network, Click Add to initiate a search, and 
choose the queue that you want.

Fig. 16� - The Port Settings controls will vary according to 
the type of port that you have set for your engraver.
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a)	 Choose Queue menu >> Manage Queues to open the 
Queue Manager dialog (Fig. 16).

b)	 Set the Port drop-list according to how you intend to 
output jobs to the engraver.
For guidelines about port selection, review “Choosing 
the Port” on page 42.

c)	 In the Port column, click [...] to adjust the Port Settings.
23.	 Skip the following Direct to Port Setup section, and proceed 

to Engraver Options

Direct to Port Setup
24.	 Set the Method = Direct to port (Fig. 17).
25.	 Set the Port Location for the machine.

For guidelines about port selection, see “Choosing the 
Port” on page 42.

Engraver Options
26.	 Click the Engraver Options tab (Fig. 18).
27.	 These controls are specialized in the sense that they 

are used to compensate for unexpected drift in tool 
motions, which can occur when the engraver is in need of 
maintenance.
Of course, it is preferred that engraver maintenance 
be performed in order to correct unexpected drift. 
However, these controls are provided for emergency 
situations, wherein the customer absolutely needs their job 
completed right away.

28.	 At this time, we do not need to adjust the Engraver Options 
controls, so click OK to close the Plotter Setup dialog.

29.	 Click OK to close the Output dialog.
30.	 At this point, we are ready to construct objects on the 

workspace, and to output those objects to your engraver. 
Please proceed to “Creating a Tool Path” on page 44.

Fig. 17� - When setting the Port Location, consider the 
comments that are provided with the driver.
Engraver tab >> Notes button

Fig. 18� - The Engraver Options provide a workaround for 
an engraver needs maintenance, but you have a job that 
needs to be completed right away.
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Choosing the Port
Whether you are setting the port location within Vision 10 
Software (or within the Production Spooler), your choice will 
depend upon the type of cable that connects your computer 
with the engraver.
For specific advice concerning your choice of port setting, and 
its configuration, please click the Engraver tab >> Notes button 
(Fig. 19).
If there are unexplained (or intermittent) communication 
problems when sending jobs to your engraver, then it would be 
prudent to perform a test with an alternative (known working) 
cable, in case your original cable is faulty.
Similarly, an overly long cable can cause signal attenuation, 
such that the job data is not being fully received by the 
engraver. In such cases, it is good practice to abide by the 
manufacturer’s recommended cable length for the given 
engraver.

☐☐ File - In the vast majority of cases with CNC routers, the 
port will be “FILE:”, and the router will have a system for 
downloading the output file that is generated by Vision 10 
Software.
For more information, please refer to the Operator Manual 
that was provided with the router.

☐☐ USB - Depending upon what Windows has detected, there 
can be multiple USB ports available, and their names can 
vary.
If output does not appear to be working for a given USB 
port, then the wrong USB port might have been selected. 
Try choosing another USB port.

☐☐ TCP/IP - For an engraver on your network, you must specify 
the IP Address and Port number used with that engraver.

☐☐ Serial - Also known as a COMM port. This is a good choice 
because it supports bi-directional communications, which 
is needed for certain functionality, such as polling the 
device, and plotter jog.
For your COMM port settings, you will need to set the baud 
rate, parity, data bits, stop bits, and flow control settings for 
the engraver.

☐☐ LPT - This is essentially an older style of printer port. Though it 
would generally work with a given plotter or cutter, a serial 
port would be the better alternative.

Fig. 19� - For the selected engraver, click the Notes button 
to review port configuration comments that are specific to 
your engraver.
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Creating a Tool Path
See also: “Rotary Engraving” on page 197

At this point, Vision 10 Software has been configured to send 
output to your machine. Now we want to create a design and 
assign a tool path that can be output for cutting.
Previously on the Output dialog, if you had chosen to set 
depth/pressure settings on the engraver control panel (rather 
than use tool paths), then create a star shape (Fig. 20) and 
proceed to “Previewing and Cutting Your Design” on page 
46.
31.	 On the Vision 10 Software workspace, use the Shape Tools 

>> Star tool to create a rectangle shape (Fig. 20).
32.	 With the rectangle shape selected, left-click the Online 

button from the Tool Path Tools flyout.
Right-click will automatically apply the previously set tool 
path information (if any).

33.	 The Online dialog will open (Fig. 21)
34.	 Set the tooling information that will be stored within the tool 

path object (i.e., the loaded tool, the cutting depth, and 
the on-screen color of the tool path).

35.	 Click OK to create the tool path object.
36.	 The resulting tool path will appear like a stroke on the 

rectangle, and the color will be the same as set within the 
Online dialog.
If the tool path is not visible, then check the View menu >> 
Show Tool Paths option.
If you want the tool path to simulate the width of the 
cutting tool, then check View menu >> Show Tool Diameter 
option.

Fig. 21� - Set the tool, cutting depth, and 
on-screen color of the toolpath that will be 
created.

Fig. 20� - Create a shape (1) within the plate size, and then 
apply a tool path (2).
If you do not need tool paths for your workflow, then just 
create the shape.
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Previewing and Cutting Your Design
At this point, you have configured Vision 10 Software for output 
to your engraver, created a basic object on the workspace, 
and (according to your workflow) created a tool path object 
for the basic object.
Now we can perform an on-screen preview of your design, 
and proceed with output of the design as an engraving job.
37.	 Using the Select tool, draw a marquee to select your 

design.
38.	 Choose Engrave menu >> Output
39.	 If you had previously enabled Engrave by Color, then you 

will be prompted to choose ONE of the colors in the design 
(or a tool path color). After sending output for that color, 
you will be prompted for the next color, and so on.

40.	 The Engrave Preview will show the design as it would be cut 
upon the material (Fig. 22).
Note the following about our example screenshot:

A) The star shape is positioned as it was within the plate, 
but our sign plate is smaller than the engraver bed.

B) Contrary to our previous advice, the plate size was 
not set equal to the machine limits of the engraver.
This can be fine when it suits your needs, and you can 
reposition the plate size upon the engraving bed.

C) The green rectangle bounds indicate the actual 
machine limits that have been set for the engraver.

D) Note the visual indication of the starting tool position, 
which corresponds to the Origin that was previously 
set on the Engraver Setup dialog.

41.	 In the SmartBar, you can confirm that the Device and Tool 
are the same as you had previously configured for output.

42.	 At this point, the cut data is ready to be sent from Vision 
10 Software. Please confirm that the machine is online and 
loaded with the appropriate material.

43.	 At the far-right of the Cut Toolbox (Fig. 23), click the 
Engrave button to begin sending cut data.
For the File-type of output port, you will be prompted for a 
filename and file location before generating the cut data.

Fig. 22� - The Engrave Preview is primarily used to visually 
confirm that your design will be engraved within the correct 
location of the engraver bed.

Fig. 23� - The Cut Toolbox provides commands for 
manipulating the job prior to output, such as rotate, flip, etc.
At the far-right, click the Engrave button to output the job.
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Preparing a Laser Engraving Job (printer driver)
The following sections describe how to configure a laser 
engraver, where the manufacturer has provided a printer 
driver (i.e., output will be sent using the File menu >> Print 
command).
1.	 From the Windows Start menu, launch Vision 10 Software.
2.	 By default, the Plate Size dialog (Fig. 24) will query for the 

size of your engraving bed. 
Typically, the Width and Height are set according to the 
Machine Limits of your engraver.
These settings can be modified later using Layout menu >> 
Plate Size.

Set a Default Color Palette
3.	 From the Options menu, choose Palette >> Load >> Set 

Default.
This command is also available through the Shop Palette 
context menu.

4.	 The Default Palette browse dialog will open.
5.	 From the Vision 10 Software install directory, browse to the 

Palettes >> Engrave directory.
The Engrave directory contains color palettes for different 
manufacture of laser engraver. Each palette contains 
colors used by the given manufacturer to indicate speed 
and power.

6.	 Choose the color palette that corresponds to your laser 
engraver, and then click the Save button.

7.	 From the File menu, start a new workspace by choosing 
New.

8.	 Along the bottom of the workspace, note that the Shop 
Palette has loaded the manufacturer palette that you had 
previously set as the default.

Fig. 24� - Set the plate size according to the loaded 
material, so that you can position your design 
correctly.
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Setting Fill and Stroke Colors
With laser engravers that use a printer driver, object fill colors 
produce an engrave fill, and hairline colors produce a cutting 
line.
9.	 Set View menu >> Show Fill = ON.

10.	 Create a circle shape.
11.	 Select the circle and left-click black in the Shop Palette.

This will assign a black fill color to the circle.
12.	 Draw a square that encloses the circle.
13.	 Select the square and left-click Invisible in the Shop 

Palette.
This will assign an Invisible fill to the square (Fig. 25).

14.	 From the Stroke and Fill Tools flyout, choose Tool Diameter.
15.	 In the SmartBar, choose a Hairline style, and set a red 

stroke color.
Note: For the black fill color and red stroke color, these 
colors are defined within the printer driver to represent 
specific power and speed settings.

Printing to the Laser Engraver
16.	 From the File menu, choose Print. The Print dialog will open.
17.	 On the Printer tab, select your laser engraver.

If your laser engraver is not listed, then the printer driver for 
the engraver must be installed.
The printer driver might be 1) provided on a manufacturer 
CD, or 2) provided from the manufacturer web site.

18.	 Tick the Preview checkbox (Fig. 26).

Fig. 25� - Left-click to assign a fill color. In this example, we are 
assigning an Invisible fill to the square.

Fig. 26� - In the Print dialog, choose the printer driver 
that was provided by the manufacturer of the laser 
engraver.
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19.	 Click the Preferences tab.
20.	 Tick the Print as shown on screen checkbox.
21.	 Click the Plate Area option.
22.	 If required, tick the Print by Colors option.

The Print by Colors option is used to maintain a particular 
sequence in which the objects are cut.

23.	 On the Printer tab, click the Setup button.
24.	 The printer driver properties for your laser engraver will 

open.
The printer driver controls will vary according to your model 
of laser engraver, such as Fig. 27.
For specific instructions concerning these controls, please 
refer to the documentation provided with your laser 
engraver.

25.	 The following aspects of the printer driver should be 
confirmed:

☐☐ For the colors defined within the driver, adjust the 
power and speed settings as required.

☐☐ For each color, set the pen mode to output both 
raster and vector data.

☐☐ Confirm that the engraving area is correct.
☐☐ Set the cutting mode to Black and White.

Sending the Laser Engraving Job
26.	 From the Print dialog, click OK to proceed.

The job will be previewed (Fig. 28) according to how it will 
be output.

27.	 Confirm that the machine is online and loaded with the 
appropriate material.

28.	 From the Print Preview, click Print to begin engraving.

Fig. 27� - The printer driver controls will vary according to 
the model of laser engraver.
To learn more about the available controls, consult 
the Operator Manual that was included with your laser 
engraver.

Fig. 28� - In our setup, the plate size was set to the loaded material, 
which was also the dimensions set for the machine in its printer 
driver.
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Preparing a Laser Engraving Job (device driver)
The following sections describe how to configure a laser 
engraver, where the manufacturer has provided a device 
driver (i.e., output will be sent using the Engrave menu >> 
Output command).

Launch Vision 10 Software
Our initial task is to configure the Output dialog, which includes 
configuration of the Engraving Defaults dialog.
1.	 From the Windows Start menu, launch Vision 10 Software.
2.	 By default, the Plate Size dialog will query for the size of 

your engraving bed. 
Set the Origin position according to the starting position of 
the tool.
Typically, the Width and Height are set according to the 
Machine Limits of your engraver.
These settings can be modified later using Layout menu >> 
Plate Size.

Job Colors Dialog
3.	 Of note, there is now a Job Colors dialog that mirrors the 

Jobs Palette, though the dialog provides additional laser 
engraving parameters that are tied to the given color.
Later, we will use the Job Colors dialog to assign engraving 
operations.

Engraving Defaults
4.	 From the Engrave menu, choose Engraving Defaults. The 

Output dialog will open (Fig. 29).
a)	 Verify that the Selected driver is set to your engraver.
b)	 Set the Tool drop-list to indicate the loaded tool.

The options will vary according to your engraver 
choice.
Laser Table is the default flat engraving area, whereas 
Rotary Roller and Rotary Chuck are special tools. 

c)	 Ticking the Sort option (Fig. 30) will enable prompts that 
allow you to change the sort order (prior to job output).
When the Sort option is OFF, the default is to engrave 
objects in the order of creation (i.e., Database Order).

Fig. 29� - Use the Output dialog to set default 
parameters for your machine.

Fig. 30� - Engraving by color allows you to engrave 
specific portions of your design in isolation (e.g., 
when different tools are required for each 
operation).
The available sorting controls will vary according 
to whether tool paths are enabled.
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Your chosen sort method will depend upon what you 
believe is best for your engraver, and the composition 
of your design.

d)	 For the Engrave setting (Fig. 31), choose between Page 
and Sign Plate, which are applied as follows:

☐☐ Page: Cutting will commence at the machine’s 
origin point. This is useful when positioning a shape 
that needs to be cut at a specific location.

☐☐ Sign Plate: Shapes will be cut with respect to their 
relative positions within the sign plate.
Ticking the Selected checkbox will require that you 
explicitly select objects prior to sending output.

5.	 Click Apply to confirm your changes.
Tool Options

6.	 From the Output dialog, click the Tool Options button.
7.	 The Tool Options dialog (Fig. 32) is used to set the feeds and 

speeds that will be used with your machine.
Where your engraver supports more-than-one tool type, 
these settings can be customized for each tool type.
These settings can also be customized for different material 
types.

8.	 Click OK to close the Tool Options dialog.

Fig. 31� - Typically, you will want to restrict valid output objects 
to those that are on the sign plate, and which are selected.

Fig. 32� - The tool options vary according the engraver model. Set 
these options according to what is recommended for the given 
tool, and the loaded material.
Note that your Operator Manual will provide specific information 
about how these options should be set for your engraver model.
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View Files
9.	 From the Output dialog, click the View Files button to 

display jobs that are currently stored at the machine’s 
control panel.
To view pending jobs from the machine’s control panel, 
the Port setting must be EZUSB. 
Optionally, the control panel configuration can be reset. 

Machine Limits
10.	 From the Output dialog, click the Setup button.
11.	 The Engraver Setup dialog will open.
12.	 On the Engraver tab, confirm that the Machine Limits do 

not exceed the actual limits of the engraver (Fig. 33).

Port Configuration
13.	 Click the Notes button (if any), and review the 

configuration comments. These comments will provide you 
with specific advice as to what port configuration settings 
should be applied.

14.	 Click the Port tab (Fig. 34).
15.	 For output, note that the Method is Direct to port
16.	 For the Port Location, there will be several options 

according to what Windows reports as being available. 
However, you want to choose from the following:

☐☐ EZUSB: Use this port when the laser engraver is 
connected via a USB port.

☐☐ FILE: Use this port when saving output files to a USB flash 
drive, which must subsequently be connected to the 
laser engraver.

17.	 Click OK to close the Engraver Setup dialog.
18.	 Click OK to close the Output dialog.

Fig. 33� - Confirm that the Machine Limits are correct for your 
engraver. Also, click the Notes button (if any) to review port 
configuration comments that are specific to your engraver.

Fig. 34� - When setting the Port Location, consider the 
comments that are provided with the driver.
Engraver tab >> Notes button
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Assigning Cut Colors
Whereas rotary engraving involves the application of tooling 
operations to a given shape, laser engraving operations are 
determined by the shape fill color.
The Job Colors dialog displays the cutting parameters that a 
given color represents, and double-clicking that color reveals 
additional, advanced parameters.
For now, let us assign a fill color and consider its cutting 
parameters.
19.	 Note that the Job Colors dialog is initially empty because 

we have not assigned any colors yet.
If the Job Colors dialog is not visible, then use View menu 
>> Palettes >> Show Job Palette.

20.	 Within the Shop Palette, left-click the first Black color plate 
(Fig. 35). This will set the fill color to Black.
The Shop Palette is typically at the bottom of the 
workspace, and it contains all the colors that are available 
to the workspace.

21.	 From the Shape Tools flyout, choose the Rectangle tool.
22.	 Draw a polygon shape, which will have a black fill.
23.	 Tap [Space] to exit the polygon drawing state. The polygon 

should now be the current selection.
24.	 Notice that the Job Colors dialog now lists the black color 

(Fig. 36), including several parameters that indicate how 
the polygon will be cut.

25.	 Some of the key information shown is the cutting Mode 
(i.e., in what way the polygon will be cut) the Speed at 
which the polygon will be cut, and the Power that the laser 
engraver should apply.
Note: Additional parameters can be viewed by double-
clicking the color. These parameters are discussed in the 
Engraving Fill Colors section.

26.	 If any of the parameters need to be modified, then click 
the Save button afterwards. Otherwise, the parameters will 
revert to their previous values when editing this design in 
future.

Fig. 36� - The Job Colors dialog shows all the colors 
that have been assigned to shapes, and the cutting 
parameters that each color represents.
After changing any parameters, click Save to retain 
those changes.

Fig. 35� - The Shop Palette displays the available 
colors that can be applied to shapes.
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Previewing and Cutting the Tool Path
27.	 From the Engrave menu, choose Output.
28.	 The polygon will now be previewed in Engrave Preview 

mode.
29.	 Note the following:

☐☐ Crosshairs will indicate the starting position of the tool 
(Fig. 37). These crosshairs will correspond to the Origin 
selection setting on the Plate Size dialog.

☐☐ If the preview has zoomed to the rectangle, then Page 
was set on the Output dialog.

☐☐ If the preview has zoomed to the sign plate and shows 
the relative position of the polygon (within the sign 
plate), then Sign Plate was set on the Output dialog.

30.	 In the SmartBar, verify that both the Device and Tool are 
the same as were set within the Output dialog.

31.	 At this point, the cut data is ready to be sent from Vision 
10 Software. Please confirm that the machine is online and 
loaded with the appropriate material.

32.	 On the Cut Toolbox, clicking the Engrave button (Fig. 38) 
will begin the sending of cut data.
Note: If the Port Location of the Engraver Setup dialog had 
been set to “FILE:”, then Vision 10 Software will prompt for a 
filename and file location before saving the cut data.

At this point, you have confirmed that Vision 10 Software is able to 
output jobs to your laser engraver, and you should be in a good 
position to learn more about how to prepare laser engraving jobs.

Fig. 37� - The Engrave Preview is primarily used to visually confirm 
that your design will be engraved within the correct location of the 
engraver bed.
At the top right, the starting position of the tool corresponds to the 
Origin selection of the Plate Size dialog.

Fig. 38� - The Cut Toolbox provides commands for 
manipulating the job prior to output, such as rotate, flip, 
etc. At the far-right, click the Engrave button to output 
the job.
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specific workflows. For example, it is useful to decide what 
general hues will be displayed on the workspace, so that you 
can visually discern the engraving modes that have been 
applied.

Material Setting
The Job Colors dialog is organized per the Material drop-list. 
This allows you to have colors that still represent the same 
engraving modes (e.g., red for cutting, green for holes, etc), 
though vary the speed or power according to the material.
To clearly differentiate between specific named materials, 
click the [ + ] button and name each material. The engraving 
parameters of each color then need to be set for each 
material type.
The current material is also shown on the Edit Color dialog, 
though the material can only be changed on the Job Colors 
dialog.

Setup Procedures
Engraving Fill Colors

Note: This section concerns laser engravers that output jobs 
via a printer driver. For such engravers, fill colors are used 
to designate engraving operations, and stroke colors are 
simply not used.

Along the bottom of the workspace, the Shop Palette contains 
the various colors that can be assigned to shapes, text and 
bitmaps. Each color represents a specific set of engraving 
operations, such that applying a fill color defines how the given 
object will be rendered. In the case of bitmaps, the fill color 
does not affect the visual on-screen presentation, but the fill 
color does determine how that bitmap will be engraved.
The Job Colors dialog (Fig. 39) lists all fill colors that have been 
applied on the workspace. The dialog also displays the main 
engraving parameters that each color represents. More 
parameters are available, which can be viewed by double-
clicking the color to open the Edit Color dialog (Fig. 40).
Though Vision 10 Software is supplied with a handful of Shop 
Palette colors to get you started, the expectation is that you 
will add, remove and customize the colors to better suit your 

Fig. 39� - The Job Colors dialog is linked to the Job 
Palette, and both are shown via View menu >> 
Palettes >> Show Job Palette.

Fig. 40� - Double-click a color to display 
additional engraving parameters within 
the Edit Color dialog.
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•	 Passes - Indicate the number of times that the engraving 
operation will be performed. For example, it may be 
desirable to repeat a cutting operation.

•	 Output - The checkbox indicates that the shape color will 
be output. To prevent a shape from being output, clear the 
checkbox of its fill color.

•	 Material - All of the color engraving parameters are saved 
according to the selected Material. By default, the material 
is “Normal” to indicate the typical material that is loaded 
into the machine. Click the [ + ] key to add alternative 
material names.
See also: “Material Setting” on page 65

•	 Save - After changing any engraving parameters, it is 
CRITICAL that you settings be saved by clicking the Save 
button.

Additional Engraving Parameters
The additional engraving parameters available on the Edit 
Color dialog are as follows:

•	 Blower (All Modes) - This option controls the air tube that is 
used to collect small particulate.
Note: This option has no control over a manually operated 
compressor system. You must ensure that air flow is 
unobstructed during operation.

•	 When in Cut Mode, there is an additional blower choice 
between While and Always. The While option will cause 
the blower to operate only in conjunction with the laser 
firing, whereas the Always option will cause the blower 
to operate for the entire duration that the engraver is 
processing the shape.

•	 Corner Power (Cut Mode only) - Due to how the machine 
must decelerate and accelerate when cornering, this 
causes the laser to essentially linger longer than intended 
in the vicinity of the given corner (i.e., can burn the 
shape corners). By reducing the power during cornering 
operations, this compensates for the laser moving slower at 
the corners.

Saving Job Color Parameters
After configuring the engraving parameters for colors listed 
within the Job Colors and/or Edit Color dialogs, it is CRITICAL 
that your settings be saved by clicking the Save button. 
Otherwise, the next time that you load or create a design, 
you will find that changes to your engraving parameters have 
been discarded.
Since engraving parameters are associated with specific color 
values, it is useful to create a custom Shop Palette that has 
the colors you want. The Vision 10 Software help file provides 
instructions for saving your custom Shop Palette and setting as 
the default palette used by Vision 10 Software.

See also: “Backing Up Your Engraving Parameters” on 
page 69

Main Engraving Parameters
The main engraving parameters and controls on the Job Colors 
dialog are as follows:

•	 Mode - This is the type of engraving that will be applied to 
the given shape.

•	 The Cut mode is a vector engraving mode that cuts the 
shape outline (i.e., a vector shape).

•	 The Engrave mode is a raster output mode that will cut 
the entire shape by repeatedly sweeping back-and-forth 
across the entire length of the shape. This mode engraves 
bitmaps at the indicated power setting.

•	 The GradeEngrave mode is designed to create rubber 
stamps that have a slight grade along the shape contour. 
The width should be set to give the stamp sufficient 
support.

•	 The 3D mode is a raster output mode that varies power 
according to grayscale values within an image. Maximum 
power will be applied to black portions of the grayscale, 
though this will be attenuated according to lightening 
shades of gray, with white being zero power.

•	 The Hole mode simply cuts holes, either at intervals along a 
shape contour, or at the shape center.

•	 Speed - The velocity at which the shape will be engraved.
•	 Power - The wattage at which the shape will be engraved.
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Backing Up Your Engraving Parameters
Note: At the time of writing, a streamlined method of 
backing up your engraving parameter files is being 
implemented. In the meantime, your files can be backed 
up manually, as described within this section.

If you need to reinstall your Windows system, or copy 
engraving parameters for use with Vision 10 Software on a 
different system, then this section describes where to obtain 
the configuration files that contain your custom engraving 
parameters. There are two files that you need, both located in 
the main Vision 10 Software install directory.
1.	 Choose Engrave menu >> Engraving Defaults to open the 

Output dialog.
2.	 Make note of the Selected Driver.
3.	 In the Vision 10 Software install directory, there is an INI file 

that is named for the selected driver. The name will not be 
exact, but you should be able to determine a partial name 
match.

4.	 Once you have located the INI file, copy it to another 
directory in preparation for backup.

5.	 Open the INI file in Notepad.
6.	 Search for the following field:

XMLColorData

7.	 The XMLColorData field will point to an XML file.
8.	 In the Vision 10 Software install directory, locate the XML file 

and copy it to another directory in preparation for backup.

At this point, you should have both the INI and XML files ready 
for backup. To use these files with another installation of Vision 
10 Software, simply copy them into the Vision 10 Software install 
directory.
If you have more than one laser engraver, then you must 
repeat these steps for each engraver, per the Selected Driver 
setting in the Output dialog.

•	 Scan Gap (Engrave, GradeEngrave and 3D Modes) - For 
the back-and-forth motions across a shape (or image), 
the scan gap is the rate at which each successive pass 
advances across the shape.

•	 If this is set too low, then engraving will essentially dwell 
overmuch over the shape, causing excessive heat to be 
applied.

•	 If this is set too high, then engraving across the shape will 
be too fast for cutting to be effective, thereby causing lost 
detail.

•	 Grade Width (GradeEngrave Mode) - This is a slight angle 
along the shape contour that forms a supporting shoulder 
to the stamp shape.

•	 Min Power (GradeEngrave and 3D Modes) - Though it 
would be ideal that the laser have a linear power output 
from 0% through 100%, in actuality there will be lower cutoff 
(say below 15%) where there is no cutting effectiveness. 
As such, it is prudent to set this to the lower cutoff, so as 
to ensure that all cutting motions have some measure of 
cutting power.

•	 Hole in Center (Hole Mode) - If this checkbox is ticked, then 
a single hole will be placed at the center of the shape.

•	 Hole Interval (Hole Mode) - As an alternative to placing 
a single hole at the shape center, multiple holes can be 
spaced along the shape contour, per the distance that is 
specified here.

•	 Radiation Time (Hole Mode) - When burning a hole, this 
field indicates the duration for which the laser will be 
sustained upon the given point.
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Cutting Interlocking Parts Using a Laser Engraver
Engrave menu >> Create Tool Path >> Male
Engrave menu >> Create Tool Path >> Female

Wrong Mode Setting
Before previewing a job, or sending a job for output, if any of 
the design objects has an incorrect Mode, then the Wrong 
Mode Setting dialog will prompt you to correct the design. The 
incorrect object will be selected, at which point you can either 
assign a different fill color, or set a different Mode within the 
Job Colors dialog. If there are two-or-more incorrect objects, 
then the dialog will prompt you to make a correction to each 
object, one-by-one (Fig. 41).

☐☐ For bitmaps, the Mode should be either Engrave or 3D.
☐☐ For plate or contour cut objects, the Mode should be Cut.

When an object has been corrected, click OK to proceed to 
the next object (if any).

When cutting parts using a rotary engraver, toolpath 
operations are assigned to each shape, and the type of 
toolpath has a bearing upon how the tool will follow the shape 
contour (such that interlocking parts will be flush). For example:

•	 If you wanted to cut a square part that was precisely 1” 
per side, then you would apply a Male toolpath.

•	 If you wanted to cut a square part that would fit within a 1” 
square hole, then you would apply a Female toolpath.

As with rotary engravers, a toolpath operation (Fig. 42) can be 
used with laser engravers. However, an automatic conversion 
process will produce a vector shape instead of a toolpath 
operation.Fig. 41� - If there are any objects that have an incorrect 

Mode setting, then one-by-one you will be prompted to 
make correction.

Fig. 42� - To cut parts using a laser 
engraver, create either a Male or Female 
toolpath, which will be converted into 
vector data that your engraver can 
output.
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The characteristics of the vector shape will vary according to 
whether your laser engraver uses a printer driver, versus that of 
a device driver.

•	 (printer driver) The shape will have an Invisible fill, but 
its hairline color will correspond to what was set for the 
toolpath operation.

•	 (device driver) The shape fill color will be the indicated 
toolpath color, but the shape will not have a hairline.

For example, suppose that you want your laser engraver to cut 
a part, and the cut must be performed using a Male toolpath. 
The procedure would be as follows:
1.	 On the workspace, select the shape that will serve as the 

basis for the toolpath operation.
2.	 From the Engrave menu, choose Create Tool Path >> Male
3.	 The Laser dialog will open.
4.	 From the Tool drop-list, chose the tool width that will be 

simulated.
5.	 Set the Color according to the desired power setting.

•	 (printer driver) The power setting of each color is set within 
the printer driver.

•	 (device driver) The power setting of each color is set with 
the Job Colors dialog.

6.	 Click OK to create the toolpath.
At this point, instead of a toolpath, a vector shape will be 
created that will produce the desired cutting operations using 
your laser engraver.

Setting the Output Area
Layout menu >> Plate Size
Engrave menu >> Engraving Defaults (Output dialog)

From the control panel of your engraver, you have manually 
set the machine origin to a corner of the loaded material (e.g., 
top-right, top-left, etc.).
Optionally, you have jogged the cutting tool to specific 
coordinates within the material, where you want cutting to 
commence.
Within Vision 10 Software, you need to indicate the size of the 
loaded material, the origin position of the tool, and whether 
you have jogged the tool.
1.	 Plate Size dialog: Set the dimensions of the loaded 

material.
2.	 Plate Size dialog: Set the Origin selection according to the 

given corner of the loaded material.
3.	 Output dialog: Click Setup, and confirm that the Machine 

Limits correspond to the physical limits of your engraver.
4.	 Output dialog: Set the Engrave options (Fig. 43) as follows:

•	 Page: Shapes will be cut with respect to the bounding box 
of the selected design. This is useful when positioning the 
design to be cut at a specific location (e.g., after jogging 
the cutting tool).

•	 Sign Plate: Shapes will be cut with respect to their relative 
positions within the sign plate.

Fig. 43� - On the Output dialog, the Page and Sign 
Plate options determine what area of the plate size 
will be cut.



74 Vision 10 Software User Guide 75Setting the Output Area

Example - Page setting
For a rectangular piece of material, suppose that the machine 
origin position has been jogged (via the machine control 
panel) to a specific position within the material.
In this case, you would use the Page setting, so that objects 
would be engraved according to their bounding box (Fig. 44).

Example - Sign Plate setting
For a rectangular piece of material where the Sign Plate setting is 
being used, the machine origin position (via the machine control 
panel) should correspond to the corner indicated within the Plate 
Size dialog. Objects will then be cut with respect to their position 
upon the sign plate (Fig. 45).

Fig. 44� - Using the Page setting, a design will be cut with 
respect to its bounding box.
In the engraving preview, note the registration mark that 
corresponds to the Origin selection of the Plate Size dialog.

Fig. 45� - As per the Plate Size dialog in Fig. 44, the origin 
is the upper-right corner. In the engrave preview, the 
Sign Plate setting causes objects to be cut with respect 
to their relative position within the plate.
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Example - Sign Plate with Rotary Chuck
For a cylindrical piece of material (such as a ring), a rotary chuck 
attachment must be used. In order for Vision 10 Software to 
correctly drive the machine, the following conditions must be 
observed:

•	 The design must fit within the bounds of the plate size.
•	 Confirm that the origin of the plate size is correct.
•	 The height of the plate size (Fig. 46) should correspond to 

the circumference of the cylindrical work piece.
•	 In order to obtain an accurate height, it is good practice to 

measure the circumference with perhaps measuring tape, 
or a length of string.

•	 From the Output dialog, the Engrave setting should be Sign 
Plate (not Page).

Show Traveled Distance
Engrave menu >> Show Traveled Distance

For a selected object, the Traveled Distance dialog (Fig. 47) will 
state the total distance for which the laser will be On/Off, and 
this will also be represented as a percentage.

Fig. 46� - This series of repeating shapes is arranged to fit onto a 
cylindrical object of 1-inch diameter, with a width of 1/4”. As 
such, the plate height is 3.14”. Note in this case that the origin has 
been placed at the top-left, as indicated by the registration mark 
(circled).

Fig. 47� - Inspecting and comparing the traveled 
distance between jobs can aid you in estimating 
the work involved (particularly for intricate jobs), 
thereby helping you to price jobs consistently.
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Previewing a Job Before Output
In addition to the Engraving Preview that is used to confirm 
positioning of the job upon the loaded material, there are two 
additional tools:

•	 3D Viewer - Simulate the tool path movements, so you can 
verify the expected operations.

•	 This uses the Show 3D command, which is available for all 
versions of Vision 10 Software, except for laser engravers 
that output jobs via a printer driver.

•	 Output Preview - Simulate the finished job, such that 
imperfections can be identified prior to output.

•	 This uses the Show Output Preview command, which is only 
available for laser engravers that output jobs via a printer 
driver.

3D Viewer
View menu >> Show 3D

After applying tool paths to your design, the 3D Tool Path 
Viewer can be used to simulate the design as it would appear 
when being cut out of the given material. The simulated 
progress of the tool may be observed to verify the intended 
operations.
The following is a typical sequence in which the viewer could 
be used:
1.	 Import or create a grayscale bitmap.

In our example, we imported an STL file, which was 
automatically converted to a grayscale bitmap that was 
based upon our desired 2D view.

2.	 From the Engrave menu, choose Create Tool Path >> Relief 
Fill, and apply tooling operations that define the depths at 
which grayscale values should be cut per the bitmap.

3.	 With the resulting tool path selected, choose View menu 
>> Show 3D.

4.	 The 3D Viewer window will open (Fig. 48).
5.	 Optionally, at the top-right, use the texture picker to 

choose the appearance of the simulated material. Also, 
the Fill color is used in cut areas.

6.	 Click the Isometric button to set a viewing angle that will 
allow you to observe the depth of the cut design.
Use the to further move, rotate and zoom the preview.

7.	 Click the Animate button to begin the simulation of the tool 
moving across the material and cutting out the design.

8.	 If desired, the simulation can be paused, and the speed of 
the playback can be increased.
Clicking Stop will exit the animation.

9.	 Once the animation is complete, click Save to create a 
proof that a customer can inspect.

Fig. 48� - After animating a job in the 3D Viewer, the 
image can be saved as a file for use as a customer 
proof.
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Creating an Engraving Fill for Text and Graphics
Note that when simply placing one shape within another, a fill 
operation will engrave the outer shape without consideration 
of the inner object (Fig. 50). The correct technique is to 
combine two such shapes into a single path, and then the 
engraving operation may be applied.
1.	 Select the text object and then choose Arrange menu >> 

Text to Graphics.
2.	 Select both the text object and the surrounding object.
3.	 Choose Arrange menu >> Make Path.
4.	 Assign the desired engraving operation.

Output Preview
View menu >> Show Output Preview

For laser engraving jobs that will be output via a printer driver, 
use the output preview to identify issues within your designs. If 
something appears odd in the preview (Fig. 49), then it might 
need to be addressed before actually sending the job.
To help resolve issues, consider the following:

•	 Monochrome images are usually assigned an Engrave 
mode.

•	 Grayscale images generally work best with a 3D mode.
Note: These suggestions do not cover all possible design 
possibilities. The result will largely depend upon your 
particular design and the intended material that will be 
engraved. The output preview will seek to visually represent 
how a given object will appear when engraved.

Fig. 49� - For this preview of two duplicate grayscale images, 
the left has an Engrave mode, whereas the right has a 3D 
mode. In this case, the 3D mode is the correct setting.

Fig. 50� - To correctly engrave text that has been nested within 
another shape, the shapes must be combined into a single 
path.

•	 On the left are two shapes that each have been 
applied with an engraving fill color. 

•	 The middle simulates how the shapes will appear 
without combining into a single path (i.e., the outer fill 
obliterates the inner fill). 

•	 On the right, the shapes were merged into a single 
path, so that the engraving fill does not obscure the 
text.
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Creating Line Fonts
In addition to the line fonts that are included during Vision 10 
Software installation, an existing TrueType or Adobe Type 1 font 
can be used as the basis for an engraving line font. The result is 
then saved as a VEF font that can be node edited.
1.	 Choose Edit menu >> Edit Character
2.	 A special Character Picker dialog will open.

Filter Fonts for TrueType and Adobe Type 1
3.	 Click the Browse button to open the Font Detective.
4.	 Set the Group drop-list = All Fonts
5.	 Tick the Show filter checkbox.
6.	 On the Font Type tab, clear all the checkboxes except for 

TrueType and Adobe Type 1.
7.	 Click the Filter button.

Choose the Starting Font
8.	 From the Font drop-list, choose either a TrueType of Adobe 

Type 1 font.
9.	 Click the Select button.

10.	 In the Character Picker, the drop-list should indicate the 
selected font.

11.	 From the Font Operation drop-list, choose Center Line.
12.	 At this point, a progress bar will indicate completion of the 

new line font.
Several minutes may be required to complete line 
calculations for each font character.

13.	 Click the Close button.
14.	 Use File menu >> Exit to shut down Vision 10 Software.
15.	 The Save Font dialog will prompt to save the newly created 

line font.
16.	 Click Yes.
17.	 The Save Font dialog will prompt for a unique name for the 

new line font.
Make note of the font name and save location.

Using Fuse Weld
Before applying an engraving fill to overlapping objects, first 
weld the shapes into a single object (Fig. 51). This will eliminate 
tool operations from being repeating within overlapping 
regions.
1.	 Select the objects and choose Weld Tools >> Basic Weld.
2.	 Create a fill tool path via Engrave menu >> Create Tool 

Path >> Fill.

Fig. 51� - On the left is the original design. In the middle, 
the shapes were not welded before creating tool paths, 
which creates overlapping areas that will be visibly 
burnt due to being lasered twice. On the right, the 
shapes are welded into a single shape.
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Using the New Line Font
18.	 Re-launch Vision 10 Software.
19.	 Choose File menu >> Install Fonts.
20.	 Use the Install Fonts dialog to locate and install your line 

font.
The new line font will be in VEF format.

To node edit the individual letters of your line font, choose Edit 
menu >> Edit Character, and then click letters within the Character 
Picker.

Importing from CorelDraw or Adobe 
Illustrator

Vision 10 Software supports a wide range of commonly used 
file formats, such that you can work in the design environment 
that is most comfortable for you. The resulting design can 
then be brought into Vision 10 Software for further output 
preparation. The following sections provide advice about 
how to use some of the more common file formats. Though 
CorelDraw and Adobe Illustrator are mentioned, the advice 
is typical of how to use these file formats with other design 
applications.

Create a Design in Vision 10 Software
If you do not already have a design for importing, the design 
can be created in Vision 10 Software.
For designs that will be used to create multiple badges, 
creating a plate design within Vision 10 Software provides 
greater control for customizing the text frame properties to 
automatically adjust text size and kerning for each badge. See 
“Create a Plate Design” on page 97.

Import a Design from CorelDraw
Choose from the following methods to bring a design from 
CorelDraw to Vision 10 Software. To preserve font information, 
avoid converting text to graphics when importing or exporting.

A)	 From the CorelDraw Standard menu, click the Send 
to Vision 10 Software button. You will be prompted to 
choose the data format that will be sent to Vision 10 
Software.

B)	 From the CorelDraw File menu, choose Save As and 
save the design as an AI file. When saving, do not use a 
file compatibility greater than Adobe Illustrator 8.0 .

C)	 From the CorelDraw File menu, choose Export and 
save the design as an EPS file. Check that text is being 
exported as text.

D)	 From the CorelDraw File menu, choose Publish to PDF. 
Note that the PDF publish settings can be used to 
embed font information within the PDF file.
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Tracing Artwork into Cut Paths
See also: “Vectorizing Images into Line Art” on page 181

Often a customer will provide sample artwork or business cards 
that are of relatively poor quality for engraving. In such a case, 
use the AccuScan image editing features to clean up and 
trace the artwork into vector paths that can be cut.

Importing a Bitmap Image
Your Vision 10 Software installation directory contains a Tutorial 
sub-directory. Within the Tutorial directory are sample files that 
can be used with the following procedure.
1.	 From the File menu, choose the Import item. The Import File 

dialog will open.
2.	 Browse to the Tutorial directory and choose the cortech.tif 

file.
3.	 Click Import to proceed.
4.	 Click on the workspace to place the imported file (Fig. 52).

Import a Design from Adobe Illustrator
Use the following method to bring a design from Illustrator 
to Vision 10 Software. To preserve font information, avoid 
converting text to graphics when importing or exporting.

•	 From the Adobe Illustrator File menu, choose Send to Vision 
10 Software.

•	 When saving an AI or PDF file, set the subset fonts at 1% to 
embed font information within the file.

Fig. 52� - An imported image on the workspace.
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13.	 Once the image trace is complete, click the Close button 
to close AccuScan and return to the Select state. The trace 
is now grouped on the workspace.

14.	 Drag the bitmap aside, so that you can see the traced line 
art.

15.	 To see the tracings more clearly, toggle the View menu >> 
Show Fill command.

Convert the Image to Monochrome
In order to obtain the best tracing results, convert the image to 
monochrome.
5.	 Select the image.
6.	 Choose Image menu >> Mode >> Monochrome (Fig. 53).
7.	 The image will now be in monochrome format.

Tracing the Image with AccuScan
The monochrome image is now ready to be traced by 
AccuScan.
8.	 With the image selected, choose AccuScan from the Scan 

Tools flyout (Fig. 54).
9.	 The AccuScan controls will become available within the 

SmartBar.
10.	 In the SmartBar, the controls for Vectorization, Trace Setup, 

and Saved Settings are available (Fig. 55).
11.	 From the Saved Settings drop-list, choose “Small Serif Text”.
12.	 To begin tracing the image, click the Vectorization button. 

Our sample image is relatively simple, so only a moment will 
be required to complete the tracing.

Fig. 53� - From the Image menu, the Mode flyout is used to 
change the type of image.

Fig. 54� - Select the image and choose 
AccuScan. Alternatively, double-clicking an 
image will activate AccuScan.

Fig. 55� - In AccuScan mode, the tracing tools 
will become available in the SmartBar.
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4.	 Click the Blend option, so that the shades will be evenly 
distributed between the Start and End color.
The Spectrum Up/Down controls are used to adjust how 
hues are blended either clockwise or counterclockwise 
through a HLS color wheel.

5.	 Click the Render button. This will activate the controls for 
rendering the resulting contour to a bitmap image, as 
opposed to a collection of discrete cut paths.

6.	 From the drop-list, choose 256 Gray to indicate that the 
resulting bitmap should be a monochrome image.

7.	 Set the Resolution = 300 (i.e., a high resolution image).
8.	 For this example, the Opacity Settings are not needed, so 

we can leave those controls disabled.
The Opacity controls are similar to that of the Transparency 
Fill tool (see help file).

9.	 Click Close to finish adjusting the contour fill settings (Fig. 
57).

Contour Fill Tool
From the Transform menu, the Contour Fill tool (Fig. 56) 
simulates a gradient effect by creating a sequence of 
consecutive cut paths. For a selected shape, there are two 
variants of this tool: Exterior, which creates a gradient that 
follows the outer contour, and Interior, which follows the inner 
contour.

Contour Fill Example
For laser engraving, a typical use of Contour Fill is to create a 
grayscale bitmap. The following steps describe how this would 
be done.
1.	 Select the vector artwork and choose Transform menu >> 

Contour Fill >> Interior.
Note: The Exterior controls behave in a similar manner.

2.	 Using the color pickers, set the Start and End colors to black 
and white, respectively.
To avoid potential mistakes, it is prudent to pick colors from 
the shop palette.

3.	 Set the number of steps, and the width of each step, to 
obtain the desired gradient effect. The settings here will 
depend upon the artwork size, and your judgment with 
respect to how fine the gradient should be.
The on-screen handles are good for rough adjustments, 
and then specific settings can be made in the SmartBar.

Fig. 56� - The SmartBar controls for Contour Fill.

Fig. 57� - From left-to-right: original vector artwork, and the 
resulting grayscale bitmap.
Note: For engraving jobs that are sent via a printer driver, 
grayscale bitmaps should be set to a color that has a 3D 
mode in the Job Color dialog.
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The color will default to a black color that has Mode = Cut. 
However, you should use the Job Colors dialog to confirm 
the cutting parameters of this color.

8.	 Click an empty portion of the workspace to finish editing 
the contour cut path.

9.	 The contour cut path will appear as a dashed line.

Adding Cut Paths to Line Art
Suppose that a shape has an engraving fill, but you would 
also like to apply a cut path along its contour, or offset from its 
contour. This is done by creating a contour cut path, which is a 
new shape that will represent the cut path.
1.	 Select the shape, and choose Engrave menu >> Contour 

Cut. 
2.	 At the far-left of the SmartBar, select the type of contour 

cut path that you want to create.
3.	 Tick Inside/Outside to cut both inner and outer contours. 

Otherwise, only the outer contours will be cut.
4.	 Set the Corner Style according to how rounded or sharp 

the cut paths should be (Fig. 58).

5.	 Set the Offset according to how close the contour cut 
should follow the shape edge (Fig. 59).

6.	 If you selected the Miter corner style, then the Miter Limit 
field will appear.
The Miter Limit is applied between the corners of the 
original object and the contour cut. This limit is expressed as 
a percentage of the Offset amount (Fig. 60).

7.	 The Color Picker is used to choose the fill color that defines 
the cut path.

Fig. 58� - From left-to-right, the contour cut corner styles are 
corner, round, and mitre (50%)

Fig. 59� - The Offset is the distance from the shape edge to 
the cut path. In the middle, the Offset is zero, whereas the 
left shape has a positive Offset, and the right shape has a 
negative Offset.

Fig. 60� - The Miter Limit causes corners to be trimmed 
according to a percentage of the Offset amount. From left-
to-right, the percentage is 200%, 100%, and 0%.
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1.	 Select the imported image that you want to add contour 
cut paths to. 

2.	 From the Engrave menu, choose Contour Cut (Fig. 62).

Adding Cut Paths to Images
From the Engrave menu, the Contour Cut command is used to 
create cut paths for images in three ways (Fig. 61).

4.	 Set the Corner Style according to how rounded or sharp 
the cut paths should be.

5.	 Set the Offset according to how you want the cut lines 
spaced along the image contours.

6.	 The Color Picker is used to choose the fill color that defines 
the cut path.
The color will default to a black color that has Mode = Cut. 
However, you should use the Job Colors dialog to confirm 
the cutting parameters of this color.

7.	 Click Apply to create contour cut paths for the image. If 
the Bitmap Frame checkbox = OFF, then the Monochrome 
Filter dialog will open (Fig. 64).

8.	 If the resulting contour cut path is acceptable, then click 
within an empty portion of the workspace to finish editing 
the contour cut paths.

Tips When Setting the Threshold Value
Creating a contour cut path involves tracing the edges of your 
original image. To do this, Vision 10 Software will (behind the 
scenes) analyze a monochrome (i.e. black-and-white) version 
of the image to determine its edges. In such a monochrome 
image, the pixels are either black or white, with white as the 
background (Fig. 63).

3.	 At the far-left of the SmartBar are two checkboxes: Inside/
Outside and Bitmap Frame. These checkboxes control how 
cut lines are created for an image. For example:

☐☐ To cut within the rectangular bounds of the image, 
the Bitmap Frame checkbox should be OFF (no 
tick).

☐☐ To create a cut lines that follow the contour of the 
image (i.e., inner contours), the Inside/Outside 
checkbox should be ON (ticked).

Fig. 62� - The SmartBar displays the Contour Cut controls.

Fig. 63� - For an original image (on the left), a monochrome 
version will be temporarily created in order to determine 
the edges. To obtain sharper edges, it may be necessary to 
adjust the Threshold slider.

Fig. 61� - Examples of contour cut paths:
A) Create a rectangular cut line around the bounding 

area of the image.
B) Create an irregular cut line that traces the transition 

between white and dark portions of the image.
C) Create an irregular cut line that traces the transition 

along a specific grayscale value in the image.
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For your image, each pixel has a color weight that varies from 
zero (blackest) to 255 (lightest), which the Monochrome Filter 
dialog compares with the Threshold slider. By default, the 
Threshold slider is at the far-right, which indicates that only 
the lightest pixels should be white in the monochrome bitmap 
analysis. However, by moving the slider left, more of the lighter 
pixels will be considered as white, thereby adjusting the edge 
that will be traced.
To obtain the best results, it may be necessary to adjust the 
Threshold slider. The following are some tips:

☐☐ To trace the contour of an image that has a white 
background, set the Threshold to 255 (move the slider 
all the way to the right).

☐☐ To trace the contour of an image that has a shadow 
effect, set the Threshold somewhere around 200 (move 
the slider close to the right).

☐☐ If the original image is monochrome, then the slider will 
not be adjustable.

Create a Plate Design
Use the following procedure to create a plate design with text 
that adjusts to the plate margins. In later sections, we will use 
this design to create both a series with single badges per plate, 
and a series with multiple badges per plate.
1.	 Choose Layout menu >> Plate Size.
2.	 Set the Width and Height according to your badge size.
3.	 Click OK to close the Plate Size dialog.
4.	 From the Text Tools flyout, choose Frame Text Compose.
5.	 The text controls will appear in the SmartBar (Fig. 65).

6.	 Click the Center Justify button.
7.	 For the Line Layout, click Centered.
8.	 For the Toolbar Mode, choose Frame to reveal the margin 

fields.
9.	 If necessary, click the Fixed Width and Fixed Height buttons, 

such that the margin fields are editable.
10.	 Set the margins to Percent Margins, and set each margin to 

a 6.0 value (Fig. 66).

Fig. 65� - When composing text, the Text Tool controls will 
appear in the SmartBar. All text objects have a text frame, 
for which margins, justification, etc. can be customized. The 
Toolbar Mode is used to choose the available controls.

Fig. 64� - To obtain a clean cut line 
that follows the image contour, the 
Monochrome Filter dialog is used to 
force near-white hues to white.
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Create Text in the Text Frame
Now that the text frame margins and compression have been 
set, we can enter several lines of text. As new lines are added, 
text compression will be automatically applied. This text 
compression will also be applied when creating badges that 
have variable text.
15.	 When the Vertical Compression dialog was closed, the 

view returns to the text frame.
16.	 Type a line of text and press [Enter].
17.	 Type a second line of text and press [Enter].
18.	 Type a third line (Fig. 67).
19.	 As each line is added, note how the character heights are 

automatically reduced to fit the text within the text frame.
To increase emphasis on the first line, we selected the 
text and assigned a non-Italic font at a slightly larger text 
height.
We also performed a small kerning adjustment to improve 
the overall presentation.

20.	 After completing any additional text edits that you would 
like, click an empty portion of the workspace to finish 
editing.

11.	 Click the Height Compression Mode button to open the 
Vertical Compression dialog.

12.	 Click the “Compress text only when height exceeded” 
option.

13.	 From the Method drop-list, choose “Character height 
compression”.

14.	 Click OK to close the Vertical Compression dialog.

Fig. 66� - Adjusting the margins and compression settings for a 
text field.

Fig. 67� - Three lines of text that fill the text frame. We will use this text 
when creating example badges in the following sections.
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Preparing a Series of Single Plate Badges
Use the following procedure to prepare a series of badges, 
where only one badge will be cut at a time. Text substitution 
can be applied for each badge, such that the InstantReplay 
feature will automatically replicate any special effects 
that have been applied to the text, such as outlines, 
transformations, or shadows.

Note: If a plate design needs to be created, then please 
refer to “Create a Plate Design” on page 97.

Note: If a plate design needs to be imported from another 
design application, then please refer to “Importing from 
CorelDraw or Adobe Illustrator” on page 85.

Position the Initial Design
1.	 Confirm the placement of text and shapes, and apply the 

desired engraving operations.

Initial Badge Setup
2.	 Select all the elements of your plate design (Fig. 68). The 

objects selected will be replicated for each badge.
3.	 Choose Layout menu >> Badges to open the Badge Setup 

dialog (Fig. 69).
4.	 Tick the Use Plate checkbox to limit each badge to a single 

plate.
5.	 Next to the Use Plate checkbox, set the drop-list to None.
6.	 Clear the Custom Size checkbox, such that the Height and 

Width reset to the plate size.
7.	 The Page preview will be a single, white badge, as 

opposed to multiple badges arranged on a single plate.
8.	 Setting the Margins is unnecessary if you have already 

defined margins within the text field.
9.	 Set the Spacing (vertical and horizontal) to zero.

10.	 If present, clear the Compress Equally Over Copies 
checkbox (OFF).

Fig. 68� - Since we will be cutting a single badge per 
plate, the text placement indicates where the plate 
will be cut.

Fig. 69� - Use the Badge Setup dialog to set margins, 
spacing, and variable text for each badge.
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Text Substitution for Each Badge
15.	 Click OK to proceed to the Text Substitution dialog (Fig. 71).
16.	 All of the entries from the text file will now be listed.
17.	 Click OK to finish creating the badges. 

Set Variable Text
For our example, we have a tab-delimited text file that 
contains text for substitution.

11.	 In the Replaceable items / text 
list (Fig. 70), click each item for 
which text replacement should 
be applied.
The [Ctrl] and [Shift] modifier 
keys can be used when 
selecting from this list. Note 
that these items are listed 
according to the order in 
which they were created on 
the workspace.

12.	 Within the Replacement 
data file section, click the 
Browse button and choose 
the text file that contains your 
replacement text.
This example uses the “Team.
txt” file that is in the Vision 10 
Software Tutorial directory.

13.	 When the text file is loaded, 
note that the number of 
badges is updated to reflect 
the number of data entries 
found within the file.

14.	 To the right of the Browse 
button, verify that the drop-
list indicates the delimiter that 
is used in the text file. In this 
example, “Tab Key” indicates 
that the fields within the text 
file are separated by [Tab] 
characters.

Fig. 70� - Choose a 
text file that contains 
replacement text, and 
select text fields for text 
substitution.

Fig. 71� - If imported data is in the wrong column, then 
click the column header to select that column, and 
then click the Move Column Data button.
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Creating Multiple Badges per Plate
Use the following procedure to prepare a series of badges, 
where multiple badges will be arranged on each plate. Text 
substitution can be applied for each badge, such that the 
InstantReplay feature will automatically replicate any special 
effects that have been applied to the text, such as outlines, 
transformations, or shadows.

Note: If a plate design needs to be created, then please 
refer to “Create a Plate Design” on page 97.

Note: If a plate design needs to be imported from another 
design application, then please refer to “Importing from 
CorelDraw or Adobe Illustrator” on page 85.

Position the Initial Design
1.	 When creating multiple badges per plate, the initial 

placement does not matter because the badges will be 
automatically positioned on the plate size.

2.	 However, do apply the desired engraving operations 
because these operations will be re-applied for all of the 
resulting badges.

The Finished Badges 
18.	 When the badges have been completed, the workspace 

will display the first badge in the series (Fig. 72).
Re-applying operations for text substitution is part of 
the InstantReplay functionality that is built into Vision 10 
Software. 
Note that engraving operations have also been re-applied 
where there has been text substitution.

19.	 To view the remaining badges, use the Sheet Page palette 
at the bottom of the workspace (Fig. 73).

Fig. 73� - At the bottom of the workspace, use the 
Sheet Page palette to browse additional badges.

Fig. 72� - After badges have been created, the view will 
return to the workspace, where text substitution for each 
badge has been completed.

Fig. 74� - With multiples of this badge design being 
created per plate, we won’t see the finished plate 
positions until after the badges are created.
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break cleanly.
8.	 Within the Plate section, tick the Custom Size checkbox 

and set the Height and Width according to the plate that 
has been loaded into the machine. For our example, this 
was 12” by 12”.
The Page preview will now show how the multiple badges 
will be positioned on the plate.

9.	 Setting the Margins is unnecessary if you have already 
defined margins within the text field.

10.	 Set the Spacing (vertical and horizontal) to zero.

Initial Badge Setup
3.	 Select all the elements of your plate design (Fig. 74). The 

objects selected will be replicated for each badge.
4.	 Choose Layout menu >> Badges to open the Badge Setup 

dialog (Fig. 75).
5.	 Clear the Use Plate checkbox, such that multiple badges 

can fit within a single plate.
6.	 Next to the Use Plate checkbox, choose Score Lines from 

the drop-list.
7.	 Use the color picker to choose an appropriate score line 

color.
For laser engravers that use a printer driver, this color should 
have speed and intensity that will allow the badges to 

11.	 If present, clear Compress 
Equally Over Copies = OFF

Set Variable Text
12.	 For our example, we have 

a tab-delimited text file that 
contains country names 
and the name of their 
representative

13.	 In the Replaceable items / text 
list, click each item for which 
text replacement should be 
applied (Fig. 76).
The [Ctrl] and [Shift] modifier 
keys can be used when 
selecting from this list. Note that 
these items are listed according 
to the order in which they were 
created on the workspace.

14.	 Within the Replacement data 
file section, click the Browse 
button and choose the text file 
that contains your replacement 
text.
This example uses the “Team.
txt” file that is in the Vision 10 
Software Tutorial directory.

15.	 When the text file is loaded, 
note that the number of 

Fig. 75� - Use the Badge Setup dialog to set margins, 
spacing, and variable text for each badge.

Fig. 76� - Choose a 
text file that contains 
replacement text, and 
select text fields for text 
substitution.
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badges is updated to reflect the number of data entries 
found within the file.

16.	 To the right of the Browse button, verify that the drop-list 
indicates the delimiter that is used in the text file. In this 
example, “Tab Key” indicates that the fields within the text 
file are separated by [Tab] characters.

Text Substitution for Each Badge
17.	 Click OK to proceed to the Text Substitution dialog (Fig. 77).
18.	 All of the entries from the text file will now be listed.

Along the bottom of the Text Substitution dialog, note the 
shortcuts that can be used to rearrange the columns.

19.	 Click OK to accept the Text Substitution fields, and Vision 10 
Software will proceed to create the badges. 

Fig. 77� - If imported data is in the wrong column, then click 
the column header to select that column, and then click the 
Move Column Data button.
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Adding Plate Objects to Badges
After multiple badges have been arranged for a sheet, any 
unused space can be filled with plate objects. The trick is that 
when creating the badges, they must be created as “plate 
objects.”
1.	 Select the initial badge design and choose Layout menu 

>> Badges.
2.	 The Badge Setup dialog will open.
3.	 At the top-left, there is a drop-list for choosing the type of 

score lines or crop marks that will mark the bounds of each 
badge.

4.	 From the drop-list choose Plate Object (Fig. 80).
5.	 For the Page preview, click either the top-left, or bottom-

left.

The Finished Badges
20.	 When the badges have been completed, the workspace 

will display the first page of badges (Fig. 78).
21.	 To view the remaining pages of badges, use the Sheet 

Page palette at the bottom of the workspace (Fig. 79).

Fig. 80� - In order to add plate objects to badges, 
the badges themselves must be defined as 
“plate objects” in the Badge Setup dialog.

Fig. 79� - At the bottom of the workspace, use 
the Sheet Page palette to browse additional 
badges.

Fig. 78� - After badges have been created, the view will 
return to the workspace, where text substitution for each 
badge has been completed.
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When badges are created as plate objects, they cannot 
be laid out from the top-right, or bottom-right.

6.	 Proceed with the remaining steps of your badge creation.
7.	 After badges have been created, suppose that the 

badges have filled several pages, but the final page is 
about half full.

8.	 Choose Layout menu >> Plate Object >> Create Plate.
9.	 In the SmartBar, set the Width and Height for the plate.

10.	 Click Apply, and the new plate will be appended within 
the available space of the last page (Fig. 81).

Adding Text to a Plate
To add text to a plate, first choose the Text Compose tool, and 
then click within the plate. The text frame will match the plate 
dimensions.

Creating More Plates
After creating a set of plates, there are two methods of adding 
more plates. 

A) Select the set of plates, and then choose Layout >> 
Plate Object >> Add Another Plate.

B) Select the set of plates, and then press the [Page Down] 
key.

Conversely, plate objects can be removed by using either the 
Remove Last Plate command, or by pressing the [Page Up] key. Fig. 81� - After creating badges that have been defined 

as “plate objects,” additional plate objects will be 
placed within available space.
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Photo Laser – Preparing an Image for 
Laser Engraving

The Photo Laser tool is used to prepare an image for output 
through a laser engraver. Various image filters are available for 
improving the quality of the image, and you can choose from 
preset settings that have been configured for different types of 
material. Since a laser engraver is essentially a monochrome 
device (laser on or laser off), any color information retained in 
the image is not useful, so the resulting photo laser image will 
be in monochrome format.
1.	 Import an image onto the Vision 10 Software workspace.
2.	 From the Transform menu, choose Photo Laser >> 

Interactive.
3.	 The Photo Laser dialog will preview the effect of applying 

the various filters (Fig. 82).
4.	 In the Filter list, right-click will toggle a filter between ON/

OFF.

Using Preset Filter Settings
Click the Load Presets button to choose from an assortment 
of parameter files that have been configured for various 
materials.

Note: Presets typically include an additional background 
image for you to visually judge how your image will 
appear when engraved upon that material. Right-click the 
Simulation filter to view the background image.

Suggestions for adjusting filters from scratch
If you wish to adjust the Photo Laser settings without using 
preset values, then it is recommended that you start with only 
one filter, and then incrementally increase the number of filters 
until you achieve the desired results. For example:

•	 Right-click to turn OFF all the filters, except for the 
Histogram filter.

•	 Adjust the Histogram filter to trim excess shadow (Black) 
and excess highlight (White).

•	 If necessary, adjust the midtones (Gamma) to obtain more 
balance in the resulting shades.

•	 At this point, the image can be further refined by 
incrementally turning on more filters, one by one, and 
making adjustments as appropriate.

•	 For example, turn ON an Edge filter, set it to Unsharp Mask, 
and then adjust the Amount, Radius and Threshold to find 
values that produce good results.

•	 Then turn ON the Threshold filter and adjust the Threshold 
slider to help sharpen the image.

Fig. 82� - In the On/Off column, right-click to toggle a filter. 
When loading a filter preset, right-click the Simulation filter to 
simulate how the image appears upon that type of material.
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specifications for barcode size, line thicknesses, and types 
of valid characters. Generally, the customer will specify the 
type of barcode and any additional constraints that you must 
adhere to.
Fortunately, Vision 10 Software will automatically constrain the 
data according to the type of barcode. For example, you will 
be prevented from entering illegal values. If you are not sure 
what the legal values are, then use the Character picker.
Barcodes can be combined with serialization from the badges 
feature, such that barcode values can be incremented 
automatically. Serialization will be demonstrated in the next 
section, Creating Barcodes Using Badge Serialization.
The following are the basic steps for creating a barcode:
1.	 From the Shape Tools flyout, choose Barcode (Fig. 84).
2.	 In the SmartBar, the barcode controls will become 

available (Fig. 85).
3.	 Set the Type of barcode according to the customer 

specifications.
4.	 In the Value field, enter the text and/or numeric values that 

will be converted into a barcode.

Creating a Barcode
A barcode is an arrangement of vertical lines (of varying 
thickness and spacing) that form a machine-readable label. 
Depending on the type of barcode, the label can contain 
either numeric or alphanumeric data, which may then be 
scanned using a barcode reader.
There are a variety of barcode standards, each with their 

Output the Photo Laser Job
5.	 From the Photo Laser dialog, click OK to apply the filter 

settings (Fig. 83).
If Keep Original = OFF, then the resulting image will replace 
the original.
If Keep Original = ON, then the resulting image will be 
placed beside the original.
If Simulation = ON, then an additional simulated image will 
be placed beside the other image(s), and it can be shown 
to the customer as a proof.

6.	 Before output, confirm that the image has been assigned a 
fill color that represents the desired engraving settings.

7.	 Choose Engrave menu >> Output to preview the job 
placement.

8.	 Confirm that the machine is online and loaded with the 
appropriate material.

9.	 From the Cut Toolbox, click Engrave to begin engraving.

Fig. 83� - From left-to-right, the original image, the image 
that is ready for output, and a simulated image that can be 
shown to a customer as a proof.
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5.	 If there is an unusual character that must be entered in 
the Value field, then use the Character picker to choose 
characters that are valid for this type of barcode.

6.	 If a human-readable caption is required, then click the 
Caption button.

7.	 The other SmartBar controls will vary according to the 
type of barcode. To learn more about the barcode 
symbologies, please refer to the help file.

8.	 To create the barcode, click Apply, and then click on the 
workspace to place the barcode.

Creating Barcodes Using Badge Serialization
The Badges feature is used to create duplicates of a design, 
where new text can be substituted for each badge. For 
example, badges may be used to create nameplates for 
doors, identification cards for employees, or adhesive labels.
Often, text substitution is performed by reading names and 
related information from a text file that is provided by the 
customer. In addition, serialization can be used to increment 
a numeric or alphanumeric value for each badge. Likewise 
for badges that include barcodes, the barcode value can be 
incremented for each badge.
For the following steps, suppose that you have created a 
barcode and positioned it along with some supporting badge 
text. For simplicity, we will assume that only the barcode value 
is variable.
1.	 Choose Layout menu >> Badges.
2.	 In the Badges Setup dialog (Fig. 86), set the various control 

according to your production setup.
3.	 In the Replaceable items / text area, click the barcode 

value to indicate that it is selected.
4.	 Click OK to close the Badges Setup dialog.
5.	 The Text Substitution dialog will open (Fig. 87).

Fig. 84� - Create barcodes from the Shape Tools flyout.

Fig. 86� - For this example, we want the barcode 
value to be variable, so the barcode value is 
selected.

Fig. 85� - When creating a barcode, first choose the type of 
barcode (i.e., the symbology).  The available controls and 
values will then be restricted to that type of barcode.
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6.	 The initial barcode value will be listed as a column header. 
Click this header to select the entire column.

7.	 Click the Serialization button.
8.	 The Serialize dialog (Fig. 88) will provide controls for setting 

the initial starting value and increments for the series.
9.	 In the Start field, highlight the characters that should be 

variable.
10.	 Click the Set as Base button, such that the highlighted 

characters will be variable.
11.	 Set the Increment = 1.
12.	 Set the Base = Number to indicate that the variable text is 

numeric.
13.	 Click OK to close the Serialize dialog.
14.	 Click OK to close the Text Substitution dialog.
15.	 The badges will now be created (Fig. 89).

Fig. 87� - Click the header to select all the cells within 
that column, and then the Serialization button can be 
clicked to create a series.

Fig. 88� - The Serialize dialog is used 
to choose the starting text that will 
be variable, and the amount that 
the value should increment for 
each badge.

Fig. 89� - The resulting badges have text substitution, and 
the barcode values are incremented for each badge.
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Chapter 1
The Vision 10 Software Workspace

In This Section…
☐☐ Workspace customization
☐☐ Locations of menus, color palettes and toolbars
☐☐ Methods of creating shapes and text
☐☐ Selecting shapes and basic layout controls
☐☐ Setting fill and stroke colors
☐☐ Creating gradient fills and color blends

The center of the Vision 10 Software environment is the 
workspace, which includes grid lines, horizontal and vertical 
rulers, and a rectangular outline to represent the plate size.
The plate size dimensions are usually set equal to the material 
that is being machined, such that the placement of art and 
text can be visualized. However, for some design work it may 
be more convenient to hide the plate size.

Quick Customization Tips
Depending on the other software packages that you are 
familiar with, you may have certain preferences for how the 
workspace is set up. The following are some of the Vision 10 
Software workspace settings that may be of immediate use to 
you:

•	 Options menu >> Vision 10 Setup >> General Preferences 
– Set the basic workspace settings that are generally 
common to all features

•	 Options menu >> Vision 10 Setup >> System Preferences – 
Configure basic product functionality, usually as a one-time 
configuration

•	 View menu >> Show Plate – This is used to turn on the 
rectangular area that helps you visualize the size of the 
material that you are working on

•	 View menu >> Show Fill – This is used to show the fill color of 
line art shapes. Turn this off to see only the wireframe view 
of shapes
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Shape Creation
From the Tools toolbar, the Shape Tools (Fig. 90) are used to 
create circles, rectangles, polygons, stars, arrows, and fan 
shapes. These shapes are sometimes referred to as “parametric 
shapes” because they have extra editing handles for adjusting 
the shape parameters, such as number of sides, notched 
corners, rounding, etc.
From the Tools toolbar, the Graphic Edit Tools (Fig. 91) are used 
to edit scanned or imported vector artwork. Often, scanned 
artwork has extra nodes and rough edges that need to be 
“cleaned up” using these node editing tools. In addition, the 
Graphic Edit Tools can be used to draw freehand shapes and 
trace simple artwork.

See also: “Polygon Editing Hot Keys” on page 213

•	 View menu >> Show Bitmap Outlines – This is used to show 
only a wireframe rectangle of bitmap shapes

•	 View menu >> Link Show Fill and Bitmap Outlines – When 
Show Fill is toggled, also causes wire frames to be shown 
instead of bitmap image.

•	 View menu >> Show Tool Diameter – Illustrate the widths 
that tool paths require

•	 View menu >> Show Grid – This is used to display the grid 
lines

•	 Options menu >> Grid – This is where objects can be set to 
snap to the grid lines

•	 Options menu >> Guides – This is where guidelines can be 
created or removed

Menu, SmartBar, and Toolbars
Above the workspace is the menu bar, the SmartBar, and one-
or-more toolbars.

•	 The menu bar is typical of most Windows applications.
•	 The SmartBar is a special, dynamic toolbar that displays 

controls that are specific to the current operation that is 
being edited.

•	 The other toolbars are customizable. Buttons may be 
added or removed from these toolbars. New toolbars may 
also be created.

Color Palettes
Below the workspace are the color palettes.

•	 The Shop Palette is the main color palette that displays 
colors that are available for use as either fill or stroke colors.

•	 The Sheet Page Palette is used to manage multiple pages, 
such as created by the Badges feature, or when importing 
multiple page PDF documents. 
See also: “Color Palette Tips” on page 216

Removing excess nodes when node editing
1.	 From the Shape Tools flyout, create an oval shape.
2.	 Select the oval and choose Arrange menu >> Convert to 

Polygon.
3.	 Double-click the oval to begin node editing.
4.	 Drag a marquee to select all of the nodes.
5.	 Press the ‘ u ’ key to select only alternate nodes.
6.	 Press the [DEL] key.

Fig. 90� - Basic shapes that are 
available from the Shape Tools 
flyout.

Fig. 91� - Node editing 
is available from the 
Graphics Edit Tools 
flyout.
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From the Tools toolbar, the Slice Tools (Fig. 92) are used to 
subdivide selected shapes. The Open Path tool will leave the 
subdivided objects as open paths, whereas the Close Path tool 
will create closed paths.
When either Open Path or Close Path is chosen, click on the 
workspace to place one-or-more cutting nodes that intersect 
the selection. Then click Apply to subdivide the selection.

Text Creation
From the Text Tools flyout (Fig. 93), the Text Compose tool is 
used to create text shapes. When creating text, the text frame 
determines the bounds of the text, such as the following:

•	 Click on workspace: This will set an entry point for the text. 
As text is typed, the text frame will expand and contract to 
enclose the text.

•	 Click along a shape contour: Hold the cursor over the 
edge of a shape, such that the cursor turns black. Click 
and type text to fit text to the shape contour.

•	 Click and drag marquee: Dragging a marquee with the 
mouse will set the text frame bounds. As text is typed, the 
text frame will remain fixed, and the text will be constrained 
according to the text frame properties.

•	 Press [Ctrl] and click along a shape contour: This will 
activate the Fit Text to Frame feature, where text can be fit 
to irregular non-rectangular shapes.

•	 Press [Shift] and click on workspace: This will set the text 
frame equal in size to the plate size. 

•	 Frame Text Compose button: This button will set the text 
frame equal to the plate size.

The Spell Check tool will check the spelling for all text shapes.
The Text Underline tool will create underlined text. Right click to 
set the underline properties.
From the Transform menu, the Fit Text to Arc command is used 
to fit the text to a circular contour.
From the Transform menu, the Fit Text to Path command is used 
to fit the text shape to the contour of another shape.
From the Transform menu, the Fit Text to Frame command will 
cause text to fit within another shape, such as an irregular non-
rectangular shape.

Fig. 92� - Subdivide 
shapes using the Slice 
Tools flyout.

Fig. 93� - Text Compose is available 
from the Text Tools flyout.
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Selecting Shapes
See also: “Selecting and Manipulating Shapes” on page 
217

Left-click a shape to select it. The [Shift] key can be used to 
add/remove shapes with respect to the current selection.
To select multiple shapes, click-and-drag the cursor to 
form a marquee. All shapes that are within the marquee 
will be selected. Alternatively, use the Lasso Selection tool 
[Shift + Ctrl + a] to draw an irregular shaped marquee. All 
shapes that are within the marquee will be selected.
If the [Ctrl] key is pressed when dragging a marquee, then all 
shapes that are overlapped by the marquee will be selected.
By default, a shape can be selected by clicking within its filled 
region. Alternatively, press the [ALT] key to only allow a shape 
to be selected by clicking along its contour. This is useful when 
you are attempting to select from among several clustered 
shapes. For example, when node editing a shape that overlaps 
other shapes, press the [ALT] key to prevent accidentally 
choosing a different shape.
Vision 10 Software can be set to select shapes only when they 
are clicked along their contours. From the Options menu, 
choose Vision 10 Setup >> General Preferences >> Selection 
Tool Settings. If the “Use Filled Region to Select” option is 
unchecked, then shapes can only be selected by clicking 
along their contours.

Job Palette Color Selection
The Job Palette may be used to select shapes according to 
their color.

Select all shapes of a specific color or tint
1.	 In the Job Palette, click [...] and choose Color View from 

the context menu.
2.	 Press [Shift] and then left-click a color in the Job Palette.
3.	 All shapes of that color will be selected.

Select all shapes of a specific spot color
1.	 In the Job Palette, click [...] and choose Foil View from the 

context menu.
2.	 Press [Shift] and then left-click a color in the Job Palette.

From the Weld Tools flyout (Fig. 94), the Basic Weld is used to 
bond script lettering, such that there is no overlap between 
adjacent characters.
However, keep in mind that the result of the weld will no longer 
be a text shape, so make sure that the text is correct before 
doing the weld.

Fig. 94� - For script lettering, kern the 
lettering and then use the Basic 
Weld tool.
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•	 Mirror: Flip the shape either horizontally or vertically.
•	 Flip: Similar to mirror, except that the line of reflection can 

be adjusted.
•	 Clear Size/Move: Remove all Size, Move, Slant, Rotate, 

Mirror, or Flip operations that have been applied to the 
shape.

Adding Fills and Strokes
The Shop Palette contains the colors that can be applied to 
shapes as fill or stroke colors. In addition, the Job Palette will list 
all colors that are currently being used on the workspace.
For a selected shape, left-clicking a Shop Palette color will 
change the fill color, and right-clicking will change the stroke 
color. The Shop Palette also has a Line/Fill button, which is used 
to alternate this behavior.
When there is no selection, the SmartBar indicates the default 
fill and stroke colors that are applied to new shapes. Within 
the Shop Palette, a white hairline is drawn about the default fill 
color.
A newly created shape has no stroke, so its stroke color is not 
initially visible. From the Stroke and Fill Tools flyout, the Line Style 
tool is used to add a stroke.
At the far-left of the Shop Palette is the Invisible Color. All other 
colors have a letter designation (P, SF, or SC) to indicate their 
type.

Types of Colors
•	 Invisible Color: Indicates the absence of color. For 

example, when a shape fill is Invisible, only its thick line 
attributes (i.e., its stroke) are available for printing or 
cutting.

•	 Process (P): Use the Process option when process colors are 
being used (i.e., where CMYK colorants are combined to 
produce a given color).

•	 Spot Foil (SF): Used to represent colors that will be printed 
with foil cartridges (i.e., pure colorants are applied, rather 
than by combining proportions of CMYK). Shades of spot 
foils are created by adjusting the Tint values (less than 
100%), or by applying a gradient.

•	 Spot Color (SC): Defined in terms of the LAB color space, 
and used to represent distinct color planes when printing 
color separations.

3.	 All shapes of that spot color will be selected, including tints 
of that color.

Properties of Shapes
When a shape is selected, nine editing nubs appear about 
the shape. These nubs are used to move, resize, scale, flip, 
and rotate the shape. The SmartBar displays the position, size, 
rotation, color information, and type of the shape.
Of the nine editing nubs, the SmartBar indicates the Current 
Nub with a red highlight, and the SmartBar x and y values 
represent the position of the Current Nub. When the SmartBar is 
used to resize a shape, the shape will be resized with respect to 
the Current Nub.
Of the nine nubs indicated within the Current Nub, there is a 
tenth Anchor Nub. The Anchor Nub is like a variable nub that 
can be repositioned over the selected shape.
From the View menu, the Show InstantReplay item will activate 
the InstantReplay window, which is used to list the changes 
(properties and operations) that have been applied to a 
shape. Double-clicking will edit the property or operation 
without changing the order in which it was applied. Pressing 
the [Delete] key will reverse changes to a selected property, 
and it will remove a selected operation.
Using the cursor keys, a shape is moved (“Nudged”) one pixel 
at a time. Holding [Shift] will move the shape by five pixels.
When rotating a shape, press [Ctrl] to constrain rotation to the 
Snap Angle, which is set on the General Preferences dialog.
When dragging a shape, press [Ctrl] to constrain the move 
horizontally or vertically. In addition, pressing [ALT] will create a 
duplicate of the moved shape.
From the Layout menu, the Size/Move commands are also 
used to modify the shape properties, as follows:

Layout Menu Size/Move Commands
•	 Size: Set width and height of shape, or set scaling amount.
•	 Move: Place shape at an absolute position, or move the 

shape by a relative amount.
•	 Slant: Slope or skew the shape either horizontally or 

vertically.
•	 Rotate: Rotation can be with respect to a specific point on 

the workspace.
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Blends using Metamorphosis
From the Transform menu, one of the functions of the 
Metamorphosis tool is to create a smooth gradient 
blend between two line art shapes. Depending on the 
metamorphosis setting, either new colors can be created, or 
existing Shop Palette colors will be used.

•	 Target layer: Use the currently selected Shop Palette color
•	 Match layers: Locate and use only colors that are currently 

in the Shop Palette
•	 New layers: Create and add new colors to Shop Palette

Metamorphosis creates the effect of a gradient blend by 
creating a large number of intermediate shapes. For example:

Create a metamorphosis color blend
1.	 Create some blue text with 1” height.
2.	 Create a red duplicate of the text with 5” height.
3.	 Select both text shapes and choose Metamorphosis from 

the Transform menu.
4.	 Set the Mode to New Layers, such that new color plates will 

be created.
5.	 Set a high Count value, such as 64.
6.	 Click OK, and the resulting series of line art shapes will 

create the effect of a gradient.
To create a blend that fades to “no color,” then assign the 
Invisible Color to one of the shape fills.

Gradients and Pattern Fills
From the Stroke and Fill Tools flyout (Fig. 95), the Gradient Fill 
tool is used to create a process color gradient. When printed, 
this fill will be rendered using CMYK colorants.
From the Stroke and Fill Tools flyout, the Pattern Fill tool is used 
to tile a bitmap pattern on the shape.
From the Stroke and Fill Tools flyout, the Transparency Fill tool 
behaves like the gradient fill tool, except that object opacity is 
adjusted instead of color.

Fig. 95� - Apply gradient fills and patterns 
from the Stroke and Fill Tools flyout.
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Chapter 2
Shape Manipulation

In This Section…
•	 Arranging collections of shapes
•	 Applying special effects to shapes
•	 Clipping intersecting shapes
•	 Dissecting shapes with the Slice Tools
•	 Converting text shapes into line art

There are many tools available that allow you to modify or 
combine shapes.
From the View menu, choose Layer Viewer to display how 
shapes are arranged upon each layer. Shapes on a higher 
layer will appear above shapes on a lower layer.

Ways to use the Layer Viewer
1.	 Drag a shape to either above or below another shape, or 

drag a shape onto a different layer.
2.	 For a selected shape, click the Show Object Attributes 

button to display the operations and attributes of that 
shape, which can then be double-clicked to edit.

3.	 For a selected layer, click the Show Layer button to toggle 
the visibility of that layer. Similarly, you can lock layers, or 
set them to be either print-only or cut-only.

From the Arrange menu, the Order To Front and Order To Back 
commands are used to control the display order in how shapes 
appear above each other. Similarly, shapes can be moved 
Forward and Backward in the display order.
From the Layout menu, the Group command is used to bind 
shapes into collections, which allows the shapes to be moved 
as a single unit. The Ungroup command is used to release the 
collection. 
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Outlines and Inlines
From the Transform menu, the Outline command is used to add 
the effect of contour lines either around a shape (Outline), or 
within the shape contour (Inline). The Create Mask option will 
weld the resulting outlines and/or inlines into a single shape.
From the Transform menu, the Contour Object command 
is similar to the Outline command. A positive Offset will 
create an outline, whereas a negative Offset will create an 
inline. Overlapping portions of the contour object will be 
automatically welded into a single shape.

Transformation
From the Transform menu, the Transformation command is 
used to apply special effects and distortions to shapes and/or 
images. Each transform comes with two versions: Vertical and 
Horizontal (Fig. 96).

Note: The following three transformations are not available 
when editing images: Perspective Curve Vertical, and 
neither of the Fit to Circle transforms.

Double-clicking a group of shapes will open the Group Viewer, 
which lists the shapes that are part of that group. Selecting a 
shape within the Group Viewer will display all the attributes and 
operations that have been applied to that shape.

Ways to use the Group Viewer
1.	 Double-click an attribute for one of the shapes within the 

group. Changes to that attribute will only apply to that 
shape without changing the group.

2.	 Drag a color from the Shop Palette, and drop it onto the 
“Layer” attribute within the Group Viewer. The fill color of 
the shape will be changed.

3.	 Select a shape that is not part of the group, and use 
InstantReplay (see InstantReplay) to look at the operations 
that have been applied to that shape. Drag an operation 
from the InstantReplay window, and drop it into the list 
of operations displayed within the Group Viewer. The 
operation will be automatically re-applied to the shape 
that is selected within the Group Viewer.

From the Tools toolbar, the Weld Tools are used to fuse shapes 
together into a combined shape. Alternatively, the weld tools 
can clip overlapping shapes. In either case, the weld tools 
actually create new shapes.
From the Arrange menu, the Clipping command is used to 
clip overlapping shapes to the top-most shape. This is similar 
to a weld, except that the original shapes are not destroyed, 
and the Clipping Clear command can be used to reverse the 
effect.
From the Tools toolbar, the Slice Tools are used to subdivide 
shapes. The subdivided shapes can either become closed 
contours, or they can be left as open paths.
From the Arrange menu, the Text to Graphics command is 
used to convert text shapes into line art. This is usually done in 
order to combine the text shapes with other line art.

Metamorphosis
From the Transform menu, the Metamorphosis command is 
used to blend two shapes together, and multiple intervening 
shapes with distinct gradients can be created.

Fig. 96� - There are six categories of Transformation 
commands available, all but three of which can also be 
applied to images.
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Shadow
From the Transform menu, the Shadow command is used to 
add background shapes that create the appearance of 
shadows (Fig. 97).

•	 Block Shadow: The Block Shadow is used to give shapes 
the perception of depth.

•	 Perspective Shadow: The Perspective Shadow is used to 
give shapes the perception of distance.

•	 Drop Shadow: The Drop Shadow is similar to the Block 
Shadow, though the perceived space between the 
original shapes and their shadows is not filled.

•	 Cast Shadow: The Cast Shadow is used to create the 
perception of a light source, such that the shapes project a 
shadow as if onto a nearby surface.

At the far-right of the Shadow SmartBar, the Outline checkbox 
(Fig. 98) is used to increase the thickness of the shadow effect. 
When creating a shadow outline, the following outline options 
may be used:

•	 Point: Corners of the shadow outline are sharp
•	 Miter: Corners of shadow outline are clipped (See “Miter 

Limit” on page 139)
•	 Round: Corners of the shadow outline are rounded and 

smooth
•	 Relief Shadow: Create a gap (equal to the Thickness 

setting) between the shape and  the shadow outline

Fig. 98� - As an option, tick the Outline 
checkbox and increase the shadow 
thickness.

(a) (b)

(c) (d)

Fig. 97� - The available Shadow styles are (a) 
Block Shadow, (b) Perspective Shadow, (c) 
Drop Shadow, and (d) Cast Shadow.

Miter Limit
For outlines and shadows, the Miter Limit is the 
percentage at which corners will be clipped (Fig. 99). 
The miter limit is calculated as a percentage of the 
outline or shadow thickness.
Only corners that are less than or equal to 90 degrees 
will be clipped.

Fig. 99� - Two star shapes with outlines. The 
second star has an outline that has been 
clipped at 70%.
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Creating a striped stencil pattern
1.	 Create a shape and apply a red fill color.
2.	 From the Options menu, choose Vision 10 Setup >> General 

Preferences.
3.	 In the General Preferences dialog, the Duplicates section 

has X Offset and Y Offset settings. Set both these fields to 
zero.

4.	 Click OK to close the General Preference dialog.
5.	 Select the shape and choose Edit menu >> Duplicate (or 

use the [Ctrl + D] shortcut).
6.	 The duplicate has now been created precisely above 

the original. However, the duplicate is now the current 
selection.

7.	 With the duplicate still selected, apply a blue fill color.
8.	 From the Shape Tools flyout, apply a Stencil effect to the 

duplicate.
9.	 After the Stencil has been applied, the original shape will 

show through from below the duplicate.

Decorative Border
The Decorative Border tool is used to create a border shape 
that encloses either the plate size or selected shapes. The 
Decorative Border tool (Fig. 100) is available from both the 
Shape Tools flyout, and the Layout menu.

Round Corners
From the Transform menu, the Round Corner tool is used to 
create rounded corners for either inside or outside contours of 
vector shapes.
Most of the parametric shape tools include extra controls for 
rounding corners. However, the Round Corner tool is useful 
for scanned or imported vector shapes that would otherwise 
require node editing to create the rounded corners.

Stencils
From the Shape Tools flyout, the Stencil tool (Fig. 101) is used 
to create the appearance of work that has been designed 
using a stencil pattern. Other shapes will be visible beneath the 
stencil shape.
A common stencil technique is to duplicate the shape, apply a 
different fill color, and then apply a stencil to the duplicate.

Fig. 101� - Stencil styles available from 
the SmartBar.

Fig. 100� - Decorative Border 
styles available from the 
SmartBar.
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Chapter 3
Layout Tools

In This Section…
•	 Creating guides for aligning design elements
•	 Aligning shapes to the grid, plate size, or other shapes
•	 Resetting the grid lines and ruler origin
•	 Creating arrays and sequences of shapes
•	 Nesting shapes to minimize wasted media
•	 See also: “Create a Plate Design” on page 97
•	 See also: “Preparing a Series of Single Plate Badges” on 

page 100
•	 See also: “Creating Multiple Badges per Plate” on page 

105

Guidelines
When dragging shapes, guidelines are used for precise 
alignment. A shape will “snap” to the location when dragged 
near a guideline.

Opening the Edit Guides Dialog
•	 When there is no selection, right-clicking on the workspace 

will open the Edit Guides dialog.
•	 Under the Options menu, choosing Guides >> Edit Guides 

will open the Edit Guides dialog.
•	 Double-click a guide for editing within the Edit Guides 

dialog.

Creating a Guide
•	 Use the Edit Guides dialog.
•	 Right-clicking a ruler will create a guide.
•	 For a selected shape, press [Shift] and right-click the shape 

nubs to create guides (not when editing a parametric 
shape).

•	 To add guides when node editing, press [Shift] and right-
click the node.
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•	 Snap Vertically/Horizontally: Move the shape, such that the 
nub is at the nearest grid line.

From the Options menu, the Reset Origin command will set 
the grid size according to the General Preferences setting. This 
is useful when the Set Origin or Resize Grid commands have 
been used.

Alignment Tool
From the Layout menu, choose Arrange and Distribute >> 
Alignment. The Alignment controls will appear in the SmartBar 
(Fig. 103).

Note: The Align command will reapply whatever settings 

Moving, Locking, and Hiding Guides
•	 When dragging a guide, press [Shift] to constrain the guide 

to the nearest ruler increments.
•	 To lock guides in place, right-click the workspace to open 

the Edit Guides dialog and check Lock Guides.
•	 To temporarily hide the guides, choose Options menu >> 

Guides >> Use Guides [Alt + W].
•	 To remove a guide, press [Shift] and right-click the guide 

(when there are no objects selected).

Guide Labels
☐☐ In the Edit Guides dialog, click the Label Font button.

The Grid and Align Palette 
Press the [Control] key and right-click the workspace to display 
the Align Palette (Fig. 102), which is used to align shapes with 
respect to the grid. Typically, these tools are applied to shape 
nubs, though they may also be used when node editing.

•	 Set Origin: Set the grid origin to the selected location.
•	 Resize Grid: Resize the grid increments based on the 

distance between the selected location and the grid 
origin.

•	 Snap to Grid Intersection: Move the shape, such that the 
nub is at the nearest grid intersection. were last used with the Alignment tool.

See also: “Align Selected Shapes” on page 210
•	 Align to plate size: Shapes are aligned relative to the plate 

size
•	 Align to grid: Shapes are aligned relative the grid lines
•	 Align to last object: For several selected shapes, align the 

shapes according to the last shape selected in the group
•	 Align to selected: For several selected shapes, align the 

shapes according to the bounding box that is around the 
selection

The following two options are used when aligning text shapes:

•	 Treat Text Line as an Object: Enabled when using equal 
vertical spacing. For a text paragraph that has multiple 

Fig. 103� - Alignment options available from the SmartBar.

Fig. 102� - Select a node, and then use [Ctrl + right-click] to access 
the Align Palette.
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3.	 Click each subsequent shape, one-by-one. A connecting 
line is drawn as each shape is clicked.

4.	 Click on an empty portion of the workspace to finish 
editing.

The Start Sequence by Vector command is similar to the Start 
Sequence command, except that multiple shapes are added 
to the sequence by drawing a line. 

Creating a Sequence by Vector
1.	 Select the first shape.
2.	 From the Layout menu, choose Start Sequence by Vector.
3.	 Click and drag the cursor to form a line. All shapes that are 

intersected by this line will become part of the sequence.
4.	 Click on an empty portion of the workspace to finish 

editing.
Both the Start Sequence and Start Sequence by Vector 
commands can be used to arrange shapes. Repeat steps 
(1-3), and then right-click and drag the shapes across the 
workspace.
The Start Sequence by List command will open the Sequence 
by List dialog, which provides a visual list of all the shapes that 
are on the workspace. Shapes at the front of this list will appear 
above other shapes, and shapes at the back will appear 
below. The mouse can be used to drag shapes within this list. 
Alternatively, select a shape and use the To Front, To Back, 
Forward One, and Back One buttons. To use the Reverse Order 
button, at least two shapes must be selected.

•	 Holding the [Shift] key will align the shapes according to 
their lower-left bounding box corner.

•	 Holding the [Control] key will constrain the shapes either 
vertically or horizontally.

The Start Sequence by Traits command will open the Sort 
dialog, which will arrange the shapes according to their 
horizontal, vertical, or relative (Nearest) positions. Alternatively, 
the Database order arranges the shapes according to the 
order in which they were created.

lines, this option will cause each line to be aligned 
separately.

•	 Ignore Descenders: Enabled when using equal horizontal 
spacing. Causes the text descenders to be ignored, such 
as for letters ‘j’, ‘p’, and ‘q’. Alignment is performed with 
respect to the text baseline.

Array
From the Layout menu, the Array command is used to arrange 
multiple copies into rows, columns, or arcs.
Enable the Within Plate Size option to prevent copies from 
being created outside the bounds that you have set for your 
plate size.
For shapes arranged on an arc, specify the arc radius and the 
range of angles over which the copies are spread.
When creating an array, the copies can be automatically 
rotated. The Spin Each option will rotate each subsequent 
copy by the Spin Amount. The Total Spin option will 
progressively rotate each copy, such that the final copy is 
rotated by the Spin Amount.

Start Sequence
From the Layout menu, the Start Sequence commands 
are available from the Sequence flyout: Start Sequence, 
Start Sequence by Vector, Start Sequence by List, and Start 
Sequence by Traits.
The Start Sequence command has two uses. The first usage is to 
arrange the database order of the shapes, which determines 
the order in which the shapes are output to a cutter. The 
second usage is to arrange shapes graphically on-screen.

Creating a Sequence
1.	 Select the first shape.
2.	 From the Layout menu, choose Sequence, and Start 

Sequence.
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•	 Allow Mirrored Parts: Allow objects to be flipped horizontally 
or vertically during the nesting process.

•	 Keep Groups Intact: If this option is off, then grouped 
shapes will be separated during the nesting process.

Error Factor of Clearance
During the nesting process, approximations are made that are 
based partly on the magnitude of the shapes being nested. 
Setting a small Error Factor will produce more consistent 
spacing between the shapes, but at a cost of more processing 
time. The following chart provides suggested Error Factor 
values, which are qualified by the broad categories of Fine, 
Medium, and Coarse. The table is based on the average 
dimension (inches or millimeters) of the shapes being nested.

Shape 
Dimension

Fine Medium Coarse

0 < Size < 100 0.1 0.2 0.5
100 < Size < 

1000
0.2 0.5 1.0

1000 < Size < 
3000

0.5 1.0 2.0

Size > 3000 1.0 2.0 5.0

Nesting
From the Arrange menu, the Nesting command (Fig. 104) is 
used to rearrange shapes into the minimum area necessary 
for printing or cutting the shapes. In this manner, the amount 
of wasted media required to output the shapes is minimized. 
Nesting may also be used to rearrange shapes across a non-
rectangular area, such as leftover media.
To nest the individual letters of a sentence, the Text to Graphics 
command must be used first. Otherwise, the entire sentence 
will be nested without rearranging the individual letters.

•	 Specify Corners: Choose the corner from which rearranged 
shapes will be placed. Nesting will begin in that corner and 
extend across the plate size.

•	 Directions: The direction in which shapes will be nested 
across the material.

•	 Rotation: Allow rotation of shapes by the specified 
maximum number of degrees. If 20 degrees, then shapes 
will be rotated in increments of 20 degrees to find the 
optimum placement.

•	 Nesting Border: The minimum distance to maintain from the 
material edge.

•	 Clearance Between Objects: The minimum distance 
between shapes.

•	 Error Factor of Clearance: For expert Vision 10 Software 
users, a value that is used to adjust nesting based on the 
average shape sizes.
See also: “Error Factor of Clearance” on page 149

Fig. 104� - Nesting controls available from the 
SmartBar.
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Chapter 4
Importing Images

In This Section…
•	 Importing and exporting files
•	 Publishing to PDF
•	 Browsing Clip-Art
•	 Scanning and tracing images
•	 Aligning scanned images to a baseline
•	 Configuring a Digitizer Tablet

Importing Files
Vision 10 Software supports a wide range of commonly used 
file formats, such that you can work in the design environment 
that is most comfortable for you. The resulting design can 
then be brought into Vision 10 Software for further output 
preparation.
The file format determines the type of data that can be 
contained within that file. For example, a bitmap (BMP) file 
contains image data, whereas a plotter file would contain 
vector data. Some file formats can contain both image and 
vector data.
From the File menu, choose Import. The Import dialog will 
open.

•	 When importing with the Merge option checked, the 
imported file will be added to the existing workspace 
objects. 

•	 If the Merge option is unchecked, then the existing 
workspace objects will be deleted.

•	 For certain types of files, the Customize button will become 
active in order to specify certain parameters for the given 
file type. For example, if the Files of type drop-list is set to 
Bitmap Files (*.bmp), then the foreground and background 
of monochrome bitmaps can be set.
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online collection of the Openclipart.org repository, which 
is composed of 60,000+ pieces of public domain SVG 
artwork.

Exporting Files
Note: For comments about common file types, see 
Importing Files in the Help File.

 
To send a design to another Vision 10 Software user, it should 
be sufficient to save (File menu >> Save) the design in CDL 
format. Alternatively, there are four methods of exporting from 
Vision 10:

•	 File menu >> Save Embedded File – For designs that have 
linked images (e.g., using the Pattern Fills tool), save all 
such linked images as embedded images. The resulting size 
of the CDL file will be increased, thought it can now be sent 
to another designer without worrying about broken links.

•	 File menu >> Export – Use this method to save in file formats 
that store both images and cut paths (i.e., EPS files, AI files, 
etc.), or that support only cut paths (i.e., DXF files).

•	 File menu >> Export Image – Use this method to save in 
file formats that support only images (e.g., BMP files, JPEG 
files, TIFF files, etc.). The Export Image dialog will prompt for 
the Color Depth and Resolution at which the image will be 
exported.

•	 File menu >> Publish to PDF – Use this method to save the 
workspace as a PDF file that can be sent as a proof to the 
customer.

Minimizing Object Nodes when Exporting
In the lower-left corner of the Export dialog is the Customize 
button, which can be clicked to open the Parameter 
Specification dialog. The available controls on this dialog vary 
according to the file type, though generally this dialog is used 
to specify the export error tolerance.
As a rule, the default error tolerance (0.001 or 1/1,000 of an 
inch) will work well with most files to reduce the number of 
exported object nodes. However, if the default values are insufficient, 
then a caution is urged against setting a high error tolerance.

•	 The Filter button is used to customize the file types that are 
listed within the Files of type drop-list.

After a file has been chosen for importing, one-or-more further 
import options dialogs will query how elements of the given file 
should be imported. The import options will vary according to 
the type of file being imported.
The Vision 10 Help File contains more information about how to 
import the following file formats:

Vision Software Formats

•	 Vision Software (CDL) Files
•	 Vision Software Backup (BAK) Files

Common Formats for Images

•	 Bitmap (BMP) Files
•	 JPEG Files
•	 TIFF Files
•	 Adobe PhotoShop (PSD) Files

Common Formats for Line Art and/or Images

•	 Adobe PDF Files
•	 Adobe Illustrator (AI) Files
•	 Adobe Encapsulated PostScript (EPS) Files
•	 AutoCAD (DXF) Files
•	 CorelDraw (CDR) Files
•	 Scalable Vector Graphics (SVG) Files
•	 Stereo Lithography (STL) Files

Clip-Art
From the Layout menu, choose the Clip Art Viewer to browse 
and open clip-art.

•	 Browse Local - Use this tab to locate clip-art on your hard 
drive, including files that were installed from the Vision 
Software Fonts & Sign Clip-Art CD.

•	 OpenClipart - This tab provides access to the entire 
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Setting the Allowable Error
Under the Arrange menu, the Convert to Curves command 
is used to convert line art into Bézier curves. Once converted 
into Béziers, the line art should scale more smoothly. When 
converting, set the Allowable Error to one-hundredth (1/100) of 
the smallest dimension of the shape. 
1.	 Suppose the line art measures 8 by 14 inches.
2.	 Units do not matter, so just take the smaller value (8), and 

divide by 100.
3.	 Therefore, the error should be 0.08 .

Align To Baseline
From the Layout menu, the Align To Baseline command is 
available from the Arrange and Distribute flyout.
For images that are scanned into Vision 10 Software, it may be 
the case that the objects are slightly misaligned with the plate 
size. The Align to Baseline feature allows these objects to be 
aligned to either the horizontal or vertical plane. In addition, 
images can be aligned to a 45 degree angle, or a custom 
angle may be set.
Before performing the alignment, a line must be defined along 
the edge the image. To define this line, two points must be set. 
Clicking within the workspace will set the first point (the point of 
rotation), and clicking again will set the second point (the snap 
point). When a snap angle is applied, the line will be aligned to 
match the indicated angle, and the image will remain aligned 
with the line.

Digitizing Tablets
From the Edit menu, the Digitizing Setup… command is used to 
configure a digitizing tablet.
Though no other intermediary software drivers are required for 
the tablet to be used with Vision 10 Software, please ensure 
that the tablet is correctly connected to the computer, 
according to the manufacturer instructions.
The Enable Digitizer option is used to enable and disable 
the digitizer. In order to reduce the load on the system, it is 
recommended that the digitizer be disabled when not in use. 
This will prevent Vision 10 Software from polling the tablet, and 
therefore free up system resources.
The Track Pen option is used to enable and disable the 

Scanning Artwork 
Note: Before using scan commands, the scanner software 
provided with your scanner must already have been 
installed.

Note: For the 64-bit version of Vision 10 Software, the 
scanner software must support 64-bit applications. This can 
be done using third-party software that supports 64-bit 
applications.
To confirm that your scanning software interacts with 64-
bit applications, there should be a file in your Windows / 
twain_64 directory.

From the File menu, the Acquire Image commands are used to 
scan images from an attached scanner.

•	 Select Source - Choose the scanner that will be used.
•	 Acquire - Create a bitmap of the scanned image.
•	 Acquire Vector - Automatically create a vector of the 

scanned image.
•	 Scan and Trace Wizard - Perform a series of steps that 

guide you through the process of scanning an image and 
tracing it into vector artwork.
See also: “The Prepare to Vectorize Wizard” on page 182

Scanning Tips
As a suggestion, set your scanning software to scale the 
artwork by a large amount, such as an increase of 1,000% (one 
thousand percent). This will provide a more detailed image 
that is easier to work with in Vision 10 Software.
If the scanned artwork is of low quality, then it may be 
desirable to use a low dpi when scanning (say 75 dpi). 
Otherwise, a high dpi will merely magnify any mistakes that are 
in the artwork.
When tracing scanned artwork, use a low Tolerance setting to 
avoid creating a large number of nodes.
After tracing is complete, the resulting shapes are grouped. To 
node edit these shapes, perform an Ungroup command, and 
then apply a Make Path operation. The resulting shape can 
then be node edited.
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tracking of the digitizing pen. In order to reduce the load on 
the system, it is recommended that the pen be disabled when 
not in use.
The Reset Baseline option is used when starting a new drawing, 
or if the original angle and position of the tablet baseline need 
to be restored. The baseline of the tablet will be reset to match 
that of the material.
The Set Baseline option is used to align the baseline in Vision 
10 Software with that of the artwork (Fig. 105). This avoids the 
requirement that the artwork be precisely aligned with the 
bottom of the tablet.

Chapter 5
Editing Bitmap Images

In This Section…
•	 Setting memory resources for Undo
•	 Types of images (Image Mode)
•	 Creating bitmap images from line art
•	 Applying three-dimensional chiseled or beveled patterns
•	 Resizing images using the Super Size tool
•	 Easy image clipping with Fluid Mask
•	 Applying color adjustments, filters and plug-ins
•	 Editing images with AccuScan
•	 Vectorizing images into line Art
•	 Using PhotoMachine to line-trace an image

Setting Undo Resources
Before we get started with editing bitmap images, we should 
highlight the fact that large images can require quite a 
bit of your workstation memory and hard drive space. This 
is particularly significant with respect to performing Undo 
operations to backtrack over your bitmap editing. If the 
number of Undo steps (and their required memory) exceeds 
the allocated resources, then older Undo steps will be 
discarded.
If you want to have more resources available for your Undo 
operations, then from the Vision 10 Options menu, choose 
Vision 10 Setup >> System Preferences >> Undo Setup (Fig. 106).

Fig. 105� - Using points of reference within the artwork, click 
to set each end of the baseline . In the SmartBar, choose 
the angle that the baseline will snap to.
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Types of Images (Image Mode)
There are five image types available for image editing: CMYK, 
RGB, Grayscale, Indexed Color, and Monochrome. To change 
the type of bitmap in Vision 10 Software, use the Image menu 
>> Mode flyout.

•	 The CMYK type is typical of subtractive color mixing (i.e., 
printed images). This mode is used where specific CMYK 
values are envisioned for a design, and it is desirable to 
avoid possible rounding differences that might occur when 
printing RGB images (i.e., converting RGB to CMYK when 
printing).

•	 Under Windows, the RGB type has the highest color depth, 
and as such is often referred to as a full-color bitmap, a 24-
bit bitmap, or an image that has “millions of colors.

•	 Converting a bitmap to Grayscale will discard all the color 
information within the image. Converting to grayscale is a 
common activity when tracing an image into cut paths, or 
when preparing an image for laser engraving.

•	 To reduce file size, bitmaps are sometimes saved as 
Indexed Color bitmaps, which can appear more granular 
because the total number of colors are limited to either 
256 or 16 colors. As such, indexed color bitmap are not 
commonly used with high-resolution images , unless a 
particular effect is desired.

•	 For Monochrome bitmaps, note that Windows defines a 
monochrome bitmap as a two-color image, where white 
is the default background color, and black is the default 
foreground color.

Scratch Disk Memory
The total amount of Undo Setup memory is the sum of your 
workstation memory and its available hard drive space. 
Knowing this limit, you have the freedom to increase the 
maximum amount, while keeping in mind that you want to 
leave enough resources for other applications. As such, this is 
a personal judgment call, but you can generally increase the 
maximum a certain amount, and if you are finding that there 
aren’t enough undo when working with your bitmaps, then 
increase the maximum amount again.

Fig. 106� - Allocate the amount 
of memory that will be available 
when undoing bitmap edits.
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Resizing Images
On the Vision 10 Software workspace, images are treated like 
objects that can be resized according to the job requirements. 
However, resizing will not change the image resolution. To 
increase the image resolution, either use the Image Size or 
Super Size Image commands.

Image Size
From the Image menu, the Image Size command displays size 
and resolution parameters for the selected bitmap. The Pixel 
Dimensions refers to the on-screen image size listed in pixels. 
The Resolution is listed in pixels per inch (i.e. like dpi or dots per 
inch). The Image Dimensions are the actual size at which the 
image will be printed or cut, expressed in the current ruler units.

Super Size Image
From the Image menu, the Super Size Image is similar to Image 
Size, except that more processing time is required to retain the 
detail quality of the original image.
1.	 On the Vision 10 workspace, scale the image to the desired 

print dimensions.
2.	 From the Image menu, choose Super Size Image.
3.	 Set the desired resolution quality of the image.
4.	 Click Apply, and the Zoom Engine dialog will open.

If no change in resolution has been specified, then clicking 
Apply will be ignored.

5.	 Adjust the Zoom Engine controls to retain the desired 
quality, and then click OK.

Rendering Bitmaps
Render to Bitmap

From the Transform menu, the Render to Bitmap command is 
used to convert a shape into a rectangular bitmap.
When the bitmap is created, empty portions of the bitmap 
will be set to white. However, for Full Color bitmaps, tick the 
Use transparency checkbox to automatically set the white 
background as transparent.
If your bitmap is not Full Color, then use AccuScan to set a 
transparent background.

Transparent Background Using AccuScan
1.	 Suppose that a bitmap has a white background that needs 

to be set as transparent.
2.	 Double-click the bitmap to enter AccuScan mode.
3.	 Above the Palette button, set the Target Color to white.
4.	 Press [Ctrl] and then left-click the Target Color.

Render Contour Bitmap
From the Transform menu, the Render Contour Bitmap 
command uses process colors to create three-dimension 
chiseled or beveled patterns. The Constant Slope option will 
cause the chisel/bevel effect to reach its maximum height/
depth at the same rate. For areas of the bitmap that have a 
short distance between the edge and center, the bitmap will 
tend to plateau. The Constant Height option will cause the 
chisel/bevel effect to dip/peak along the centerline of the 
shape. 
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6.	 With this brush, move the cursor over part of the 
background image and then left-click.
Notice that regions that were overlapped by the brush 
have now been filled with a red mask.

7.	 Continue to click other portions of the background, such 
that you are filling in the background with a red mask (i.e., 
this portion is being marked for deletion).
In addition to clicking, you can also click-and-drag to paint 
over an area.

8.	 If necessary, remove the tick from the Show Object Edges 
checkbox. This will hide the regions, such that you can 
distinguish any portions of the background that were 
missed.

9.	 When you have finished painting the background red, 
choose Image menu >> Auto-Fill Image.
The foreground of the image will be automatically painted 
green (i.e., the foreground will be kept).
Between the red and green regions, a blue blending line 
will indicate how transparency should blend the image into 
background objects. For example, using blue on human 
hair will cause that hair to appear natural against other 
backgrounds.

Fluid Mask - Easy Image Clipping
Note: Fluid Mask is an add-on feature that can be 
purchased for use with Vision 10 Software.

Fluid Mask is an intuitive tool for knocking out the background 
of an image, such as a photo of a person standing before 
scenery. The process is very much like a paint-by-numbers 
coloring book, where you paint with a green brush (the Keep 
brush) to indicate the foreground, and paint with a red brush 
(the Delete brush) to indicate background.
Suppose that you have a customer photo, such as a JPEG 
image of their child that was taken using a digital camera (Fig. 
107). However, the background of the image is cluttered and 
needs to be clipped using Fluid Mask.

1.	 Import the image onto the Vision 10 Software workspace, 
select it, and then choose Image menu >> Fluid Mask.

2.	 The Fluid Mask editing mode will launch, and the image 
will be analyzed in order to automatically identify similar 
regions of color and texture.
Several seconds may be required, and the resulting regions 
will appear much like a paint-by-numbers coloring book.

3.	 Along the top of the Fluid Mask window are three tabs: 
Source, Workspace, and Cut-out. The Workspace tab 
should be active.

4.	 On the left-hand side is the Tools toolbar.
5.	 From the Tools toolbar, choose the Delete Local Brush tool 

(Fig. 108).

Fig. 108� - From the Fluid Mask Tools toolbar, use the Delete 
Local Brush tool for painting the red background mask.

Fig. 107� - Using Fluid Mask: (a) the original image, 
(b) after Fluid Mask has identified common 
regions, and (c) the finished image with clipped 
background.
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Increase the brush size
•	 Use the square bracket keys ‘[‘ and ‘]’ to change the brush 

size.

Increase the brush strength
•	 A brush with strength zero will affect only the regions that 

you touch with the brush.
•	 A strength greater than zero will cause adjacent regions to 

be painted (e.g., like a damp brush).

Use the Clean Tool
•	 After most of a background or foreground mask has been 

filled, choose the Tools toolbar >> Clean Tool, and then 
click the given mask. Any speckles within the mask will be 
automatically painted.

Hide the Region Edges
•	 Along the bottom of the Fluid Mask window is the Show 

Object Edges checkbox. Remove the tick to reveal missed 
areas.

Undo the Paint Steps
•	 If you have painted the wrong portion of the image, then 

use the Edit menu >> Undo command [Ctrl + z].
•	 Alternatively, from the Tools toolbar, use the Erase Brush 

(there are both Local and Exact versions).

Zoom 
•	 Press the ‘z’ key to activate the zoom magnifying glass, 

then marquee-select the zoom region.
•	 To see the full size image, use the [Ctrl + 0] shortcut (control 

+ zero).
•	 Use the ‘+‘ and ‘-’ keys to zoom in and out.

10.	 From the Tools toolbar, click the Create Cut-Out button.
11.	 From the File menu, choose Save And Apply.
12.	 The Fluid Mask window will close, and the view will return to 

Vision 10.
13.	 The Prime dialog will query whether a primer should be 

automatically applied to the image. For the sake of this 
example, choose No and click Close.

14.	 The resulting image with clipped image will be placed on 
the Vision 10 Software workspace.

Fluid Mask Comments

Green for foreground, Red for background
•	 In our example, we used a red brush to paint the 

background mask, and then we used Image menu >> 
Auto-Fill Image to automatically complete the foreground 
mask.

•	 Depending on the image, we may have found it easier to 
use a green brush to paint the foreground mask, and then 
use Auto-Fill Image to complete the background mask.

Blue for busy edges (e.g., hair, fur and feathers)
•	 For images that have busy edges, the easiest procedure is 

to first use the Blend Exact Brush (blue) with a thick brush to 
paint those edges, and then use a thin brush to trace the 
remainder of the principle image.

•	 Once the image has been traced with blue, use the Keep 
Exact Brush (green) to paint within the traced image.

•	 Optionally, use Image menu >> Clean All Blend and Clean 
All Keep to catch any stray pixels that you may have 
missed.

•	 Then use Image menu >> Auto-Fill with Delete to complete 
the background.

Local Brush and Exact Brush
•	 For both green and red, there is a Local Brush and an Exact 

Brush.
•	 Use the Local Brush to paint regions.
•	 Use the Exact Brush to paint only pixels (i.e., this is a fine 

editing tool).
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photographic negative. This feature can also be used to 
invert the color of a grayscale image, making the black 
white and the white black.

•	 Posterize… – Limit the number of color levels per plane 
(red, green, and blue). For example, two levels means two 
of red, two of green, and two of blue.

•	 Histo Contrast… – Increases or decreases the contrast 
of the bitmap image, using a histogram to determine 
the median brightness. Once the median brightness 
has been determined, pixel values above the median 
are brightened, and pixel values below the median are 
darkened.

•	 Stretch Intensity – Increase the color contrast in the bitmap 
without changing the number of discrete intensity values 
(ordinary contrast adjustments can lose high- and low-end 
values).

•	 Histo Equalize – Linearizes the number of pixels in the 
bitmap, based on the specified color space (RGB, 
Grayscale, etc.).  This can be used to bring out detail in 
dark areas of an image.

•	 Balance Colors… – Redistributes the RGB values of 
individual bitmap pixels. For each pixel, its red, green, and 
blue components are isolated, and the color sliders are 
then used to increase or decrease the percentage RGB 
values within each pixel. In this manner, a color cast can 
be removed from the bitmap, or a color tinge can be 
created for an artistic effect.

•	 Swap Colors… – Swap the color channels of the original 
bitmap. This feature is useful for obtaining artistic effects 
that would otherwise be difficult to achieve using the other 
Color Adjustment tools.

Image Menu - Color Adjustments
From the Image menu, there are flyouts for both Easy 
Color Adjustments, and Color Adjustments. The Easy Color 
Adjustments are automated settings that can be used to 
quickly improve image quality. For greater control over the 
image, use the Color Adjustments flyout.

Easy Color Adjustment tools
Note: These tools can be applied multiple times to achieve 
the desired effect.

•	 Cleanup Black - Improve the contrast (i.e., appearance of 
details) within dark regions of the image.

•	 Cleanup White - Improve the contrast (i.e., appearance of 
details) within light regions of the image.

•	 Make Lighter - Reduce the depth of shadows within the 
image (e.g., increase the brightness).

•	 Make Darker - Tone down the highlight regions of the 
image (e.g., improve details in the light portions).

•	 Increase Saturation - Strengthen the distinct hues within the 
image.

•	 Blur Image - Soften details within the image.
•	 Sharpen Image - Increase the contrast of details within the 

image.

Color Adjustment tools

•	 Levels – Adjust the distribution of color intensities throughout 
the bitmap, either to correct a scanned image, or to 
create an artistic effect.

•	 Contrast/Brightness… – The Contrast setting is used to 
modify the perceived difference between light and dark 
areas of the bitmap. The Brightness setting is used to modify 
the overall intensity of the bitmap.

•	 Hue/Saturation… – Adjust the Hue, Saturation, and 
Lightness values of the bitmap.

•	 Curves… – Adjust the tonal range (shadows, midtones, and 
highlights) of the bitmap.

•	 Invert – Inverts the colors in the bitmap, making it like a 
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Stylize / Artistic filters

•	 Emboss – Applies an emboss effect to the bitmap, letting 
you specify the depth and direction of the effect.

•	 Solarize – Creates an effect that mimics the accidental 
exposure of photographic film to light. This is done by 
inverting all color intensities that exceed the Threshold 
value.

•	 Oilify – Create an oil-painting effect. For each pixel, the 
Amount indicates the number of surrounding pixels that are 
considered when creating the effect.

•	 Mosaic – Create a mosaic effect by dividing the bitmap 
into tiles of the specified size, and then averaging the pixel 
colors within each tile.

•	 Spatial Filter – An assortment of artistic filters.
•	 Halftone – Converts a bitmap with any resolution to a 

halftoned bitmap. A halftoned bitmap is a 1-bit bitmap 
that has been dithered for black and white printing or 
display.

•	 Intensity Detect – Set all pixel color intensities to 255, or 
clear them to zero. If a pixel’s intensity is between Low and 
High, then set the intensity to 255. Otherwise, clear the 
intensity to zero.

Remove Red Eye

•	 Removes the “red eye” effect that results from flash 
photography. For each pixel, only the red color 
component is evaluated.

Image Menu Filters
From the Image menu, the Filters flyout provides a selection of 
effects that can be applied to bitmap images.

Sharpen filters

•	 Sharpen – Increase or decrease the sharpness of the 
bitmap.

•	 Unsharp Mask – Despite its name, this is actually a 
sharpening function because it increases the contrast 
between light and dark areas of the bitmap. Wherever 
there is a brightness transition between light and dark, 
the light area is made lighter, and the dark area is made 
darker, such that the transition becomes more distinct.

Blur filters

•	 Average – Changes the color of each bitmap pixel to the 
average color of pixels within the surrounding pixels. This 
results in a blur effect.

•	 Gaussian Blur – Smooth or blur pixels with respect to their 
surrounding pixels. The Radius determines the surrounding 
area that is considered when blurring a pixel.

•	 Motion Blur – Blur the bitmap to create the illusion of 
movement within the image. Positive angles indicate a 
clockwise blur, and negative angles indicate a counter-
clockwise blur.

•	 Median Filter – Changes the color of each bitmap pixel to 
the median color of pixels within the surrounding pixels.

Noise filters

•	 Add Noise – Add random pixels to the bitmap. Adding 
noise can be an effective means of making an image 
appear older or dirtier, especially where the purpose is to 
distract the eye from imperfections in the original image.

•	 Despeckle – Removes speckles from the bitmap, such as 
those present in scanned images.
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Image Menu Plug-In Filters
Plug-ins are software modules that are used to create special 
effects for bitmaps. These modules may be obtained through 
either Adobe or third-party plug-in developers.
After plug-ins have been installed on your computer, go to 
Vision 10 Software and use Image menu >> Options >> Plug-In 
Paths to indicate the hard drive location of the plug-ins. The 
plug-ins will then be available under the Vision 10 Image menu.

Note: Some plug-ins require that a foreground and 
background color be set. In this case, use the Set 
Foreground Color and Set Background Color commands.

The Plug-ins Helper Dialog
Whereas plug-ins are typically designed only for bitmaps, 
Vision 10 Software can also apply plug-ins to line art, or to a 
combination of line art and bitmap objects (Fig. 109).
By using line art as the basis for your plug-in effect, the resulting 
effect can be clipped to the line art.  In this way, the following 
advantages are obtained:
1.	 The “empty” portions of the plug-in bitmap are usually set 

to a white color, which are undesirable when arranging the 
bitmap with surrounding objects. Clipping to the original 
line art will hide the empty portions of the bitmap.

2.	 The bitmap that is produced by the plug-in will often have 
a jagged edge, which will look poor when scaled up to a 
large poster size. Clipping will “trim” the jagged edge, such 
that scaling is acceptable.
Note: A good alternative to case (2) is to scale your original 
line art to the desired size before applying the plug-in 
effect. Line art shapes will scale without diminishing their 
details.

Fig. 109� - When plug-ins are applied to line art, the Plug-ins 
Helper dialog is used to define how the effect will be applied 
to the line art.

Fig. 110� - The plug-in effect will be constrained to the line art.
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marble surfaces.
•	 Motion Blur – Create the appearance of motion within an 

image.
•	 Outer Glow – Simulate a light source that emanates 

outward from the principal object. The effect is best 
applied to vector (or text) object that is above a bitmap.

•	 Pixelate – Create the impression of a low resolution image.
•	 Radiance – Create a sense of fluidity within a loose 

structure (e.g., shaggy fur, oil on water) or distortion effect 
(e.g., radiating flames, rising smoke, choppy water).

•	 Shadow – Using a vector shape as a guide, the Shadow 
effect will create a shadow distortion upon an underlying 
bitmap.

•	 Sharpen – Provides a variety of parameters for improving 
image crispness.

•	 Silver – Similar to the Bevel filter, except that additional 
controls are provided for modifying the metallic lustre and 
lighting of the effect.

•	 Sketch – Create the appearance of a hand sketched 
artwork.

•	 Wood Effect – Generate the appearance of realistic wood 
surfaces.

Plug-ins: Harry’s Filters™
Note: More of this type of plug-ins are available through 
the Plug-in Site: www.thepluginsite.com

Vision 10 Software includes sixty-nine (69) plug-ins that are 
available through a single dialog interface. From the Image 
menu, choose The Plug-in Site >> Harry’s Filters. The available 
plug-ins are:

Color
•	 Add Color – Adjust the RGB color channels within the 

image.
•	 Cartoon Art – Assign an off-tone pallor that suggests an 

artist’s rendition.
•	 Colorize – Vary the image hues as if the image were based 

Plug-ins: Production Plug-ins
The Production plug-ins are used to perform a finishing 
modification that prepare an image for output, such as for 
garment printing. These plug-ins are available via Image menu 
>> Production Plug-ins.

•	 KnockMeBlackOut - For printing on black garment material, 
reduce the amount of black ink that is required.

•	 KnockMeColorOut - For printing on color garment material, 
reduce the amount of color ink that matches the garment 
color.

•	 Transparency Opacity - Adjust the relative strength of the 
transparency layer, thereby adjusting the amount of white 
underbase that will be printed.

•	 Posterize – Resample the image according to discrete 
color regions, as would be used when creating color 
separations.

Plug-ins: Vision Software Effects
In addition to the third-party plug-ins, Vision Software provides 
a new set of in-house plug-ins, which are available through the 
Image menu >> Vision Software Effects flyout.

•	 Bevel - Create a raised, three-dimensional chiseled or 
beveled effect.

•	 Box Blur – Add vertical and/or horizontal blur to an image.
•	 Lighting Effects  – Combine up to six (6) distinct light sources 

to create the effect of artificially illuminating the image.
•	 Sphere Effects – Introduce one-or-more distortions that 

simulate raised sphere surfaces.
•	 Tilt Effects – Change the image perspective to create the 

sensation of depth.
•	 Easy Color Adjustments – Like Image menu >> Easy Color 

Adjustments, except all of the controls are provided within 
a single dialog.

•	 Gaussian Blur – Smooths or blurs pixels with respect to their 
surrounding pixels.

•	 Marble Effect – Generate the appearance of realistic 
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Gradients
•	 Beam – Subject the image to a strong light source.
•	 Chaos – Introduce sporadic shading throughout the image.
•	 Double Sphere – Apply a color distortion that exudes from 

the image center.
•	 Frame – Border the image with the appearance of vertical 

color strips that convey a sense of change or progress.
•	 Mixed Beam – Overlay the image with filtered colors, as if 

there were multiple color light sources.
•	 Mixed – Shift color regions within the image as if it were the 

product of a complex screen print.
•	 Mystic Mountain – Apply colors with a dream-like quality.
•	 Quad Beam – Burnish the image as if it were subjected to 

sources of strong white light.
•	 Star – Burnish the image as if it were subjected to an intense 

source of white light.
•	 Spirals – Superimpose concentric circles that suggest 

disorientation or activity.
•	 Triple – Intense hues of vertical bands or concentric circles.

Patterns
•	 Radial Sinality – Explosive rays or bands of varying 

amplitude that convey energy and inspiration.
•	 Sinfinity – Suggestive rays or bands of varying hues and 

amplitude.
•	 Rasper – Overlay curves and patterns like images from a 

contemporary fashion magazine.
•	 70s Pop – Overwhelm the image with a storm of multiple 

color light sources.
•	 Random Art – Intense rays or bands that suggest mood and 

transition.
•	 Symbol Shaper – Horizontal bands that suggest vision and 

realization.

Warp
☐☐ Wonderland – Ripple the image like water distortion or 

waves of heat.
☐☐ Tiled Glass – Divide the image into blocks of glass.

upon a monotone print.
•	 Color Mood – Introduce sharp color contrasts.
•	 Color Wizard – Like Color Mood, except with pastel color 

contrasts 
•	 Expose – Create over- and under-exposure effects that are 

reminiscent of developed film.
•	 Twilight Colors – Sombre mood that suggests dim lighting 

(e.g., dawn or dusk).
•	 Old Film – Simulates the graininess of film that has begun to 

deteriorate due to age.
•	 Inversity – Stark hues that suggest the presence of 

overhead lighting.

Artistic
•	 Atmospherizer – Rotate the spectrum of colors as if the 

image were being viewed through a transparent color 
sheet of plastic film.

•	 Blurry Painting – Present the image as if it were a watercolor 
or composed of paint daubs.

•	 B/W Limiter – Attenuate the color values within the image 
to emphasize its grayscale components.

•	 B/W Limiter Pro – Combine a grayscale with hints of color 
from the original image.

•	 Color Cocktail – Emphasize kaleidoscopic transitions and 
color shifts.

•	 Crochet Art – Superimpose the image with a pattern that 
suggests the texture of knitted cloth.

•	 Equalizer – Suppress color values to produce a more 
subdued image.

•	 Equalizer Pro – Suppress color values to emphasize certain 
hues from the original image.

•	 YUV Intensity – Adjust the image in terms of YUV color 
model. Tends to produce pastel colors with stark contrasts.

•	 Color Compress – Produce a posterized appearance with 
intense hue shifts.
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Other
•	 Convolver – Varying emboss effects that highlight details in 

the image.
•	 File Size Reducer – Discard image data, though at the risk 

of losing image detail.
•	 Overpainting – Overlay additional color layers like rough 

paint strokes.
•	 Quadrant Flip – Divide the image into four quarters, and 

then rotate the sections.
•	 Streamer – Create vertical or horizontal motion blur lines.
•	 Zoom – Magnify a circular portion of the image.
•	 Convolver Pro – Advanced emboss effects that highlight 

details in the image.

Nature
•	 Dawning – Imbue the image with a light source that 

suggests a rising sun.
•	 Flame – Create flame lines along bottom of image.
•	 Lightning – Place jagged diagonal lines to simulate a flash 

of lightning.
•	 Polar Lights – Simulate the presence of Christmas lights.
•	 Super Nova – Classic transition effects from science fiction 

movies.
•	 Tornado – Overwhelm the image with the appearance of 

high winds and debris.

Plug-ins: Mehdi™
Note: More Mehdi plug-ins and examples are available 
through www.mehdiplugins.com

The Mehdi plug-ins provide a variety of artistic effects.

•	 Noise Shampoo – Simplify the complexion of the subject 
matter, such that the image colors are more homogeneous 
like that of computer-generated artwork.

•	 Swirl – Ripple the image like a sheet that is being blown by 
a rotating fan.

•	 Picture Chopper – Ripple the image like a sail that is 
blowing in the wind.

•	 Glass Slices – Subdivide the image into fragments or slivers 
of glass.

•	 Kamikaze – Rotate and zoom the image.

Noise
•	 Circular Noise – Create static like a television that is 

experiencing poor reception.
•	 Grain Maker – Introduce a posterization that provides the 

image with a textured appearance.
•	 Nail Art – Superimpose a lattice of curved patterns.
•	 Noisy Blur – Distort the image as if it were being viewed 

underwater or from behind a panel of thick glass.
•	 Noise Reducer – A simple noise reduction filter for imported 

images.
•	 Digital Cutter – Divide the image into vertical barcode-like 

line segments, imposing the idea of digital static.

Encrypt/Decrypt
•	 Black and White – Combine up to eight (8) noise channels 

to produce a convoluted amalgam of the image.
•	 Color – Vary each pair of sliders (Key 1 and 2, Key 3 and 4, 

etc.) to resample the color regions of the image.
•	 Moiré Decryption – Introduce posterization and static that 

suggest corrupted image data.
•	 Moiré Encryption – Introduce posterization and static that 

suggest corrupted image data.
•	 Noise – Combine up to eight (8) noise channels.
•	 Radial – Subdivide the image into concentric sections that 

suggest a high-technology cyberpunk theme.
•	 Sinus – Apply short horizontal bands of noise.
•	 Weak – General soft background noise, as would be 

caused by a loose connector on a security monitor.
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Applying Filters and Plug-Ins
When in AccuScan editing mode, the Image menu Color 
Adjustments, Filters, and Plug-Ins can all be applied to bitmaps. 
If only part of the bitmap is selected, then the effect or filter will 
only be applied to the selection.

Bitmap Palette Colors
Click the Palette button to display the current colors in the 
bitmap palette. The Image Palette dialog may be used to 
select palette colors and move them to the front or back of 
the palette.
If there is not enough space in the palette for new colors, then 
use the Merge Colors tool to reduce the number of palette 
colors.

Transparent Bitmap Color
Above the Palette button is the current Target color. The target 
color is used with the Brush and Fill tools.
The target color can be set to be transparent by pressing the 
[Ctrl] key and then left-clicking the Target color (Fig. 112).

Bitmap Editing Using AccuScan
From the Scan Tools flyout, the AccuScan tool is used to edit 
bitmaps. Double-clicking a bitmap will also activate the 
AccuScan editing mode. The AccuScan tools (Fig. 111) may 
then be used to edit the bitmap, apply filters and plug-ins, and 
convert the bitmap into a line-traced drawing format.

Selection Tools
When creating a selection, the [Shift] key may be used to 
extend the previous selection. In addition, the [Control] key 
subtracts from the previous selection.

•	 Whole Bitmap: Select the entire bitmap
•	 Ellipse Select: Select an oval area
•	 Rectangle Select: Select a rectangular area
•	 Draw Lasso: Select a freehand area
•	 Draw Select: Define an area that has an irregular shape
•	 Eyedropper: Pinpoint a color in bitmap and add it to the 

Shop Palette
•	 Palette: Select regions based on specific colors. Colors may 

be either added or subtracted from the current selection.
•	 Magic Wand: Select region based on similar colors. The 

Magic Wand setup may be used to customize what is 
considered to be “similar.”

Fig. 112� - Transparent color controls in 
AccuScan.

Fig. 111� - AccuScan controls within the SmartBar.
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Vectorizing Images into Line Art
Vision 10 Software provides two methods of vectorizing an 
image into line art. The classic vectorization method provided 
leading-edge tools that were suitable for previous Vision 10 
Software users. The new method uses the Prepare to Vectorize 
Wizard, which introduces new tools for improving the image 
quality, knocking out the image background, and posterizing 
the image colors prior to tracing.

The Classic Vectorization Method
The classic method of vectorizing a bitmap involved the 
Posterize Region and Merge Color tools to simplify the number 
of colors in the image. The following is an overview of the 
classic vectorization method:

Posterize the bitmap
1.	 In AccuScan mode, click the Posterize Region tool. 
2.	 A dialog will query whether the vectorize wizard should be 

used. Click No to use the classic method.
3.	 The Posterization dialog will query for the number of colors 

to reduce the number of colors in the bitmap, such as 8 or 
9 colors.

Merge similar colors
4.	 Beneath the Target color, click the Palette button to open 

the Image Palette dialog.
5.	 In the Image Palette dialog, click the similar colors, such 

that they have white borders.
6.	 Double-click the color these similar colors should be 

merged into. The Target color will be set.
7.	 Click the Merge Colors button, and the selected colors will 

be set to the Target color.

Vectorize the bitmap
8.	 At the far-right of the AccuScan SmartBar, choose the 

vectorization settings from the drop-list.
9.	 Click the Vectorization button.

The bitmap will now be vectorized, and the resulting vector 
shapes will be grouped.

Bitmap Manipulation Tools
The bitmap editing tools are summarized as follows:

•	 Brush – Edit the bitmap using the Target color.
•	 Move Region – Copy the selection and move it to a new 

location.
•	 Press [Ctrl] to fill the old region with the Target color.
•	 Crop Tool – Trim the bitmap to the selected area.
•	 Fill Region – Fill the selected area with the Target color.
•	 Quarter Bitmap – Reduce the resolution of the bitmap by 

50% in terms of its width and height.
•	 Extended Information – Display information concerning the 

dimensions and resolution of the bitmap.
•	 Merge Colors – Used to remove all unused colors from 

the bitmap palette, and to replace selected colors in the 
Image Palette dialog with the Target color.

•	 Posterize Region – Generating a color palette for a bitmap 
where none exists, or expand/reduce the size of the 
bitmap palette.

How to merge palette colors
1.	 Use the Posterize Region tool to reduce the number of 

colors in the bitmap to 256 or less.
2.	 Beneath the Target color, click the Palette button.
3.	 The Image Palette dialog will open.
4.	 In the Image Palette dialog, click two-or-more colors, such 

that they have white borders.
5.	 Click the Merge Colors button, and the selected colors will 

be set to the Target color.
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Import Options
12.	 The following import options will be provided when loading 

image data back into Vision 10 Software:

•	 The Prime dialog will be available for applying either a 
primer and/or highlight to the image.

•	 The Transparent Threshold dialog will open. Click OK to 
accept the default value, which is used for controlling 
visibility of image pixels.

•	 The Select Profile dialog will provide an opportunity to 
select a new color profile.

Posterization
13.	 The Posterization dialog will now allow you to choose the 

colors that the image will be reduced to.
14.	 The top half of the dialog shows the original image before 

posterization. The bottom half previews the posterization, 
where Color 1 is pure black by default.

15.	 Click Color 2 and then click a color in the original image.
16.	 Likewise, click Color 3 and choose another color in the 

original image.
17.	 Continue choosing colors, until the preview has enough 

colors to appear satisfactory.
18.	 Increase the tolerance for Color 1 (black), so that shades 

of gray are accounted for.

Vectorization
19.	 Click OK to close the Posterize dialog, and the image is 

now ready to be vectorized.
20.	 Double-click the image to access AccuScan editing mode.
21.	 At the far-right of the AccuScan SmartBar, choose the 

vectorization settings from the drop-list.
22.	 Click the Vectorization button.
The bitmap will now be vectorized, and the resulting vector 
shapes will be grouped.

The Prepare to Vectorize Wizard
This vectorization method uses the Prepare to Vectorize Wizard, 
which involves self-contained steps for improving image 
quality, knocking out the image background, and posterizing 
the image colors prior to tracing. The following is an overview 
of the Prepare to Vectorize Wizard steps:

Initial Wizard Settings
1.	 From the Image menu, choose Prepare to Vectorize 

Wizard.
2.	 The initial wizard page will query for Super Size and Image 

Background settings. Use the default amount of memory, 
click Yes to use Fluid Mask, and click OK to continue.

Zoom Engine (Super Size)
3.	 The Zoom Engine dialog will preview the image at the 

higher resolution quality.
4.	 Click OK to accept the default Zoom Engine settings.

Fluid Mask
Note: If the Fluid Mask tool is not available, then please skip 
to step (13).

5.	 The Fluid Mask window will analyze the color regions within 
the image, and thin irregular lines will be used to roughly 
identify each region.

6.	 Using the Delete Local Brush tool, click background regions 
of the image, such that they background appears to be 
filled with red.

7.	 If a portion of the foreground is accidentally filled with red, 
then use Undo [Ctrl + z] to correct.

8.	 If a portion of the background is difficult to fill correctly, 
then use the Delete Exact Brush to manually paint the 
background by dragging strokes.

9.	 When the background has been filled with red, choose 
Image menu >> Auto-Fill Image. The background will 
remain red, the foreground will appear to be filled green, 
and a blue “blending line” will appear along the boundary 
between red and green regions.

10.	 Choose Image menu >> Create Cut Out. The image should 
now appear with the formerly red portions “knocked out.”

11.	 Use [Ctrl + s] to save the image back to Vision 10.
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Chapter 6
The Production Spooler

In This Section…
•	 Creating a queue
•	 Choosing port settings
•	 Holding and sending jobs automatically
•	 Inspecting a held job
•	 Installing a new cutter and updating cutter drivers

About Production Spooler
The Production Spooler is companion software for Vision 10 
Software that provides queue management for your cut jobs. 
Though Vision 10 Software can output a cut job directly to 
the port that a machine is connected to, this requires Vision 
10 Software to monitor that output until the job is complete. 
Unfortunately, this prevents Vision 10 Software from being used 
for other tasks, such as working on another design, or setting up 
the next job that will be output. As a solution, you can output 
your cut jobs to the Production Spooler application, which is 
capable of the following:

•	 When each cut job is received by the Production Spooler, 
it is held in a queue.

•	 Optionally, cut jobs can be immediately sent from 
Production Spooler to the machine. This is enabled for 
each queue via the Start Queue button.

•	 Alternatively, the queue can accumulate jobs, until you 
are ready to begin output.

•	 After accumulating multiple jobs, you can choose which 
job to output next.

•	 When inspecting jobs, there is an on-screen preview.
•	 You can create extra queue tabs to help you sort jobs 

according to your own criteria.
•	 When there is more than one queue tab, Vision 10 Software 

can send the job to a specific queue tab.

PhotoMachine
The PhotoMachine tools are used to convert a bitmap into a 
line-traced drawing that can be cut, routed, or engraved.

PhotoMachine styles:
•	 None – Produce a grayscale bitmap
•	 Image Cut – For use with cutters only. Weeding lines for 

vinyl are produced, where thin bands represent light 
portions of the bitmap, and thick bands represent dark 
portions.

•	 Wiggle – For use with low-resolution engravers. Creates a 
pattern that appears to wiggle across the image.

•	 Output Tool Paths – For use with low resolution engravers. 
Creates a standard engraving pattern.

•	 Squares – For use with cutters only. A pattern of variable-
sized squares is used to depict the image. Smaller squares 
represent light portions of the bitmap, and larger squares 
represent dark portions.

•	 Stars – This style is similar to Squares, except that star shapes 
are used.

•	 Rain – For use with laser-engravers. Creates multiple “falling 
rain” lines for each pixel.

•	 Iron filings – This style is similar to Rain, except that all lines 
are created at random angles.

•	 3D Image – Creates a 3D tool path based on the image. 
For devices that support depth control, the tool path may 
be used to render a three-dimensional relief image on the 
loaded material.
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2.	 The Queue Manager dialog will open.
3.	 For the given device, the Port column indicates the output 

port.
4.	 Choose a port from the drop-list.
5.	 Once a port has been selected, its properties can be 

adjusted by clicking [...]
See also: “Choosing the Port” on page 42

Sending Cut Jobs Automatically
By default, queue tabs will hold cut jobs as Pending. This 
gives you a chance to inspect each job before output to the 
machine. If you want jobs to be immediately output to the 
machine without inspection, then perform the following:
1.	 Click the queue tab to indicate which queue you want to 

modify.
2.	 Click the Start Queue button (A).

If you want to halt the automatic processing of jobs, then click 
the Stop Queue button (B). Held jobs will be listed as Pending.

•	 If you want to re-start the queue, but have a job that 
should remain held, then click the Hold Job button (C). The 
job will be listed as Holding.

•	 For a job that is Holding, the Release Job button will 
change the job status to Pending.

Creating a New Queue Tab
By default, the Production Spooler will have a single queue 
tab, and the name is “Cutter”. When you create extra queue 
tabs to help organize your job production, it is expected 
that you will use meaningful names that are easy for you to 
manage.
When referring to the default queue tab, one would typically 
describe it as your “Cutter queue.” For comparison, if you 
created a second queue called “Wide Format” (named 
according to what is sensible to you), then in conversation this 
would be your “Wide Format queue.”
The procedure for creating a queue is as follows:
1.	 Choose Queue menu >> Manage Queues.
2.	 The Queue Manager will open.
3.	 Click the Add Queue button.
4.	 Proceed through the wizard steps to choose the queue 

settings.
5.	 When the wizard is finished, the new queue will be listed in 

the Queue Manager dialog.

Choosing the Port Settings
When choosing the port that your machine is connected 
to, consider the recommendations that are provided by the 
manufacturer, and the advice that others in your field suggest.
If there are communication issues with the machine, then it is 
important to confirm that a good quality cable is used. To test 
a cable, one should swap that cable with one that is know to 
be working correctly. For example, if the USB cable from that 
other machine is known to be working, then it would be useful 
for testing.
Occasionally, there can be cases where the cable connector 
has been damaged (i.e., either the external connector, or 
the internal electronics). This can be trickier to diagnose. 
However, if that machine’s cable can be tested on another 
machine, and that cable appears to be good, then the cable 
connector might need inspection.
Regardless, to set the output port in Production Spooler, do the 
following:
1.	 Choose Queue menu >> Manage Queues.

Fig. 113� - The tab indicates the active queue, and the toolbar 
provides controls for that queue.
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Installing a New Cutter
When creating a new queue, you will be provided with the 
opportunity to install a machine. However, to install a machine 
without creating a queue, use the following procedure. This 
procedure is typically used for modifying an existing queue to 
use a new device.
1.	 Choose Devices menu >> Manage Devices.
2.	 The Manage Devices dialog will list the currently installed 

machines.
3.	 Click the Install Cutter button.
4.	 Follow the wizard steps to install your device.

After the new device has been installed, it can be assigned to 
an existing queue via Queue menu >> Manage Queues.

Updating the Cutter Drivers
Note: For computers that are not connected to the 
Internet, it is assumed that you have manually obtained the 
desired drivers and support files, and have placed them in 
a directory that the computer can access.

Use the following procedure to update machine drivers and 
support files that will be used by VPM.
1.	 Choose Devices menu >> Manage Devices.
2.	 The Manage Devices dialog will list the currently installed 

cutters.
3.	 Click the Check for Online Updates button, and available 

files will be sought from the Vision Software web site.
Alternatively, if you have placed the drivers and support 
files locally (e.g., on the hard drive or CD-ROM), then click 
the Check for Local Updates button. In this case, you will 
be prompted for the location of the files.

4.	 When file updates are located, click the Update Devices 
button to proceed.

5.	 When the updates are complete, click Close.

Changing the Queue Tab Name
The queue tab name is set within the Queue Properties.
1.	 Click the queue tab to indicate which queue you want to 

modify.
2.	 Choose Queue menu >> Properties
3.	 The Queue Properties dialog will open.
4.	 On the General tab, change the Name as desired.

Adjusting the Queue Properties
When more than one queue has been created, a given queue 
can be selected by clicking its tab.
1.	 Select the queue by clicking its tab.
2.	 To edit the queue properties, click the Configure Queue 

button.

•	 Alternatively, choose Queue menu >> Properties.
•	 Alternatively, double-click the queue tab.

3.	 The Queue Properties dialog will open.
4.	 Along the left-hand side of the Queue Properties dialog, 

click the category of settings that need to be adjusted.

Inspecting a Held Job
When a job is received in a given queue, the properties of that 
job are “inherited” from the queue properties. In most cases, 
there is neither a need to inspect nor modify the job properties. 
However, in the event of an unexpected device error, then the 
error log can be inspected within the job properties.
1.	 Suppose that a job error has occurred, and the job is being 

held in the active list.

•	 Alternatively, perhaps the queue has been configured for 
jobs to be held pending.

2.	 Right-click the job and choose Job Properties.
3.	 In the Job Ticket Properties dialog, choose Other >> Log 

tab.
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Chapter 7
The Production Spooler Window

In This Section…
•	 The window layout
•	 Toolbar controls
•	 Menu controls for queues and jobs
•	 Queue properties

Window Layout
The layout of the Production Spooler (Fig. 114) is generally 
divided into two main portions, left and right.

Left Side
•	 On the left-hand side, the list of pending cut jobs are listed 

within the active queue (A).
•	 Where there is more than one queue, a queue can be 

selected by clicking its tab (B).
•	 If a queue has been configured to send its cut jobs 

automatically, then cut jobs will be removed upon 
completion.

•	 If Job Reserve = ON, then completed cut jobs will remain 
available in the Reserved List, which is below the active 
queue (C).

Right Side
•	 On the right-hand side, there is a preview pane that 

depicts the job as it will appear upon the media (D).
•	 Below the preview pane are context-sensitive controls (E).
•	 When a job is selected, the context-sensitive controls will 

pertain to that job.
•	 If you click the media (F), then the context-sensitive 

controls will pertain to the media.

Fig. 114� - In the Production Spooler, jobs are listed on the left, 
and their layout is previewed on the right.
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Queue Menu
The Queue menu contains the basic queue controls.

•	 Manage Queues - Open the Queue Manager dialog, 
which is used to create queues for new cutters, and set the 
output port for the given device.
See also: “Creating a New Queue Tab” on page 186

•	 Clear Job Errors - If a problem occurs when cutting (such 
as no media), then cut job will be put on hold. After the 
printing problem is resolved, use Clear Errors to remove the 
error flag.

•	 If a job has encountered an error condition, then the job 
properties will summarize the errors. The job properties also 
include a detailed Log of the tasks that were completed 
before the error was encountered (see the Log tab).

•	 Properties - Open the Queue Properties dialog.

Jobs menu
When a cut job is received in a queue tab, select that job and 
choose a command from the Jobs menu.

•	 Restore Jobs - Manage archived cut jobs.
•	 Remove - Delete the selected job.
•	 Rename - Change the job name.
•	 Locate Job - Highlight the job as it appears in the preview 

pane.
•	 Release - Release a held job for printing. The job status 

will be changed from Holding to Pending, and the job will 
proceed according to the queue settings.

•	 Hold - Stop the job, regardless of whether the queue is 
stopped. The job status will be Holding.

•	 Abort - Cancel the selected job (i.e., cease sending data 
to the machine).

•	 Clear Error - If a problem occurs during output (such as 
no media), the job will be flagged with an error and put 
on hold. After the problem is resolved, click Clear Error to 
remove the error flag.

Toolbar Controls
The toolbar provides at-a-glance queue management, such 
as holding and releasing jobs, starting/stopping the queue, or 
querying the machine.

•	 Open - Open a browse dialog and choose a cut file for 
output. The file will be output via the active queue.

•	 Remove Job - Permanently delete the selected job(s).
•	 Release Job - Release any job that has been held via the 

Hold Job button.
•	 Hold Job – Mark the job as Holding, and hold the job 

regardless of the queue Start/Stop settings.
•	 Cut Job - Output the selected job, such as one that is being 

held Pending.
•	 Abort Jobs - Cease further processing of the job.
•	 Start Queue - When a cut job is received, output that job 

automatically.
•	 Stop Queue - Hold all received jobs as Pending, so that jobs 

can be inspected before being output.
•	 Toggle Job Reserve – Enable the Job Reserve option in 

Queue Properties, and show the Reserved List (below the 
active queue).

•	 Interrogate Cutter – Update the Media width field (in the 
context panel).

Fig. 115� - Each queue is represented by a tab, and clicking a given tab 
will make that queue active.
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Queue Properties
The Queue Properties dialog is opened via Queue menu >> 
Properties
Each queue tab has a set of properties that are automatically 
applied when jobs are received by that queue.

If a job has encountered an error condition, then the job 		
properties will summarize the errors. The job properties 		
also include a detailed log of the tasks that were completed 		
before the error was encountered (see the Log tab).
•	 Add to Layout - This command is applied to unscheduled 

jobs (i.e., Reserved List). The given job will be moved into 
the active queue tab, with its layout shown in the preview 
pane.

•	 Cut - Begin cutting the job (i.e., send cut data to the 
machine).

•	 Archive to Disk - Store the job in an archive location, such 
that it can be restored at a later date.

•	 Properties - Open the Job Ticket Properties dialog. Page 
output refers to the device and its loaded media. Page 
content refers to the specific cut job.

Devices menu
The Devices menu provides access to the Manage Devices 
dialog, which can install new machine drivers, and update 
those drivers.

See also: “Installing a New Cutter” on page 189

General Tab
The General tab displays the fundamental queue settings, such 
as the queue name, the type of machine for which jobs are 
being accumulated, and the substrate color that will be shown 
in the preview pane.

Job Reserve Tab
The Reserve List is a short list of your frequently cut jobs. This list is 
at the bottom-left of the Production Spooler window.
If the Job Reserve option is enabled, then completed jobs will 
be automatically stored in the Reserve List.

Fig. 116� - For the active queue, the Queue Properties dialog is 
used to configure how jobs are processed when received by that 
queue.
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Chapter 8
Rotary Engraving

In This Section…
•	 Configuring the machine
•	 Adding Tools Paths
•	 Previewing the cut job
•	 Registration marks and cutter alignment
•	 Tiling jobs to fit media and machine limits
•	 Filtering cut shapes by color
•	 Recording the lifetime of the cutting tool
•	 Estimating time required to complete the job
•	 Creating weed borders around script lettering

Creating Tool Paths
By default, newly created workspace shapes are treated 
like simple contour cut paths of zero depth. To define more 
sophisticated machining paths, either use the:

•	 Tool Path Tools flyout (Fig. 117)
•	 Engrave menu >> Create Tool Path flyout 

  
If you use right-click to choose from the Tool Path Tools flyout, 
then you will automatically apply the same settings as when 
you previously used the given tool.

Log Tab
The log is used to review statistics about cut jobs as they are 
processed through the queue. In the event of problems, Vision 
Software Tech Support can use this information to help provide 
a solution.

History Tab
If enabled, the History tab will show the number of jobs 
processed, any errors, and the total process time of all jobs. 
The jobs are listed below with their start times, their individual 
process times, and any errors are noted.

Fig. 117� - A: Online, B: Male, C: Female, D: Fill, E: 3D 
Chisel, F: Drill, G: Drill Contour, H: Drill Center, I: ADA 
Profile
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Female
Defines a series of cutting paths on a designated shape, such 
that the resulting cut shape may contain a corresponding 
male shape (Fig. 120). For example, consider a polygon shape 
that is cut using a Male tool path, thereby producing a male 
cut. Suppose then that the same polygon shape is cut using a 
Female tool path, thereby producing a female cut. The male 
cut will then fit within the inner contour of the female cut.

Online
Defines a basic cutting path for which the tool will follow the 
edge of a designated shape (Fig. 118). The resulting cut will 
have an offset of zero. The Online tool path is often used 
to trace shapes in artwork without filling the shapes with an 
engrave pattern.

Male
Defines a basic cutting path on a selected shape, such that 
the resulting cut shape will fit within a corresponding female 
shape (Fig. 119). The tool path will fall to the outside of the 
shape contour, such that the offset equals one-half of the bit 
width. The Male tool path is typically used to cut shapes out of 
a material.

Fill
Defines a series of cutting paths designed to remove material 
from inside a selected shape.
Note that when simply placing one object within another, a fill 
operation will engrave the outer object without consideration 
of the inner object. The correct technique is to combine two 
such objects into a single path, and then the Fill tool path 
operation may be applied. The following steps show how this is 
done:
Assume that a text logo must be placed within a star shape, all 
of which must then be filled without losing the text.
1.	 Create text for the logo. With the text selected, choose 

Arrange menu >> Text to Graphics. This will convert the text 
into a graphic for cutting.

2.	 Create a star shape that is large enough to contain the 
logo, and then center the text within the star.

Fig. 118� - The Online tool path will 
trace the shape contour.
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Fig. 119� - The Male tool path will cut a 
shape that fits within a corresponding 
female shape.
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Fig. 120� - The Female tool path will cut a 
shape that contains a corresponding male 
shape.
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Drill Center
The Drill Center tool will place a drill point in the center of the 
selected object. If more than one object is selected, then a 
drill point will be placed at the center of each object.

Registration Marks
Registration marks are typically used in the following manner:

•	 Where multiple layers of vinyl are being used to compose a 
sign fascia, create registration marks to help with alignment 
of each layer.

•	 When loading printed media into the cutter, some cutter 
models have a sensor that can recognize the registration 
marks and align the job automatically. For cutters that do 
not include a sensor, the operator will be prompted to 
manually align the cutter tool with each registration mark.

•	 For a sheet a material, a registration mark can be used as a 
point of reference that will be used to position subsequent 
jobs (see also Plotter Jog).

Locations of Registration Mark Tools
A) From the Shape Tools flyout, the Registration Mark tool 

is used to manually place registration marks about the 
artwork.

B) From the Shape Tools flyout, the Multi-Registration Mark 
tool is used to manually offset registration marks about the 
artwork.

C) In Engrave Preview mode, the Cut Toolbox has a 
Registration Mark button.
Right-click this button to choose the position, size, and 
offset of the registration marks.
Left-click this button to place the specific type of 
registration marks.

3.	 With both the text and star selected, choose Arrange menu 
>> Make Path. Both objects will now have been combined 
into a single object.

4.	 Apply a Fill operation to the combined object. The result 
will be a filled star shape that correctly retains the text that 
was placed within it.

3D Chisel
Defines a cutting process that varies the depth of a contour 
tool (usually a conical tool, or a V-bit) along the defined path.  
The width of the cut path varies with the depth of the tool 
path. This type of cutting is used to create a “hand carved” 
effect.

Drill
The Drill tool is used to place drill points upon the workspace. 
Simply left-click on the workspace to place a drill point. For a 
selected drill point, its Depth is editable from the SmartBar.

Drill Contour
The Drill Contour tool will lay a series of drill points along the 
contour of an object or group of objects.

•	 Number indicates the number of drill points that will be 
spaced evenly along the contour of the selected object.

•	 Distance between points is used to space drill points evenly 
along the contour of the object.

•	 Offset is used with the Distance option to indicate an initial 
gap before drill points are placed. After the gap, drill points 
will be spaced according to the Distance value.

•	 Nodes represent the coordinates that are used for 
rendering the object on the computer screen. Use this 
option to place drill points according to each node. This 
feature is especially useful when used with polygons.

•	 Nodes and Distance will begin by placing drill points 
according to each node of the object. Additional drill 
points are then placed according to the distance.
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6.	 After the tile lines have been created, it is possible to select 
only some of the tiles for printing.

7.	 For example, tiles can be clicked, such that only tiles with 
an ‘X’ will be cut.

8.	 However, if none of the tiles have an ‘X’, then ALL of the 
tiles will be cut.

9.	 Click Apply to finish editing the tiles.
10.	 The individual tiles can now be repositioned via click-

dragging.

Filter By Color
The Filter By Color option is used to send only one color layer as 
output to the machine. For example, tool operations can be 
differentiated according to the color assigned to each type of 
tooling operation.
Filtering by color can be enabled as follows:
A) Engrave menu >> Engraving Defaults

Tick the Engrave by Color checkbox. This will cause the 
Filter by Color dialog to automatically open in the Engrave 
Preview state.

B) Engrave menu >> Output
From the Cut Toolbox, click the Filter by Color button.

Filter by Color Dialog
When prompted by the Filter by Color dialog (Fig. 121), choose 
the next color that will be output. As each color is completed, 
you will be prompted for the next color.
Optionally, a given color layer can be output more than once.

Plotter Jog
Note: This feature requires that the machine be connected 
to the computer via a serial (COMM) port cable and 
connector.

Plotter jog is the ability to position the cutter head by using the 
Jog dialog controls in Vision 10 Software. This feature is typically 
used to reduce wasted material by cutting new shapes within 
unused sections of media.
1.	 Choose Engrave menu >> Engraving Defaults.
2.	 From the Output dialog, tick the Jog checkbox.
3.	 At this point, either use the Shape Tools flyout to add 

registration marks, or add registration marks in Engrave 
Preview mode.

4.	 Choose Engrave menu >> Output.
5.	 At the far-right of the Cut Toolbox, click the Engrave button.
6.	 The Jog dialog will open, and the tool can be positioned 

for each registration mark.

Tile Settings
If the design exceeds the limits of either the machine or 
material, then the job must be divided into tiles that can be 
output as separate jobs. If tiles can be repositioned to all fit 
within the available material, then they can be completed as 
a single job.
When creating a design, the dimensions of the loaded 
material should be considered, and one should be mindful of 
the maximum physical limits of the machine, as indicated by 
the Operator Manual that was provided with the machine. 

Creating tiles in Engrave Preview mode
1.	 Choose Engrave menu >> Output.
2.	 In the Cut Toolbox, click the Tile button.
3.	 A dashed rectangular bounds will appear around the 

design.
4.	 Move the cursor over an edge of the bounds, such that the 

cursor becomes a bidirectional arrow.
5.	 Click-and-drag to create a tile line. Both vertical and 

horizontal tile lines can be created in this fashion.

Fig. 121� - Use the Filter Layer to choose the color 
that will be output, and then click the Select button.
If the Filter Registration Marks option is enabled, 
then registration marks will be cut with all layers.
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Weed and Power Weed
Shape Tools flyout >> Weed Border
Shape Tools flyout >> Power Weed

Note: Weed lines will not cut into a given shape.

Weeding is used with cut vinyl applications, where the cut 
shape must be peeled away from its backing. When peeling 
a vinyl shape, the risk is that it doesn’t pull easily from the 
backing, which can result in unexpected stretching of the vinyl. 
This is particularly problematic with small text shapes. 
To avoid stretched vinyl, a weed border may be created, 
which is essentially an extra rectangular cut around the shape. 
Once cutting is done, the rectangular cut can be peeled 
away, followed by the inner shape.
Power Weed is like the Weed Border tool, except that 
additional weed lines can be dragged from the edges of the 
border. Such additional weed lines are typically used to bisect 
text shapes.

Output Tool Usage
Engrave menu >> Output Tool Usage
Output Tool Usage is an estimation tool that collects statistical 
information about the performance of the tools being used 
in cutting or plotting. A variety of data is gathered about 
each tool, such as the overall distance traveled, the number 
of jobs completed, and the date of the last tool change. 
Using this data, comparisons between successive tools may 
be used to make an informed decision about when tools are 
likely to decline significantly in performance. Tools may then 
be replaced in advance of this decline, thereby preventing 
materials from being wasted by an old tool.

Estimate Time for Current Job
When using this option, be prepared to record the 
approximate time that is needed to complete the next cutting 
job. After the job is completed, you will be asked to enter the 
time that was expended in completing the job.

Note: From the Help menu, the TimeSign feature can be 
used to record the expended time.

Once the expended time has been set, use Engrave menu 
>> Show Traveled Distance to estimate how much time will 
be required to cut other jobs. By using this estimate, you can 
better manage your own time, since you will be able to work 
on other tasks and return when the current job is complete.



206 Vision 10 Software User Guide 207Appendix A - Updating Your Software

Appendix A
Updating Your Software
Updates from the Manufacturer

Over time, your engraver manufacturer may release an 
updated device driver for your machine (certain laser 
engravers use a printer driver, instead of a device driver). 
Typically, obtaining and installing such updates are 
recommended because they include fixes and improvements 
to how your computer communicates data to the machine.
Update the driver as follows:
1.	 Go to the manufacturer web site, and search their support 

section for files and information about your specific 
engraver model.

2.	 For the latest drivers that are available, there should be a 
version number listed, along with instructions to determine 
what version is currently being used by your machine.

3.	 If there is a more current driver available for your machine, 
then follow the instructions provided for performing the 
update.

Updates from Vision Software
For engravers that use a device driver, Vision Software provides 
a cutter driver that is required in addition to the manufacturer 
device driver. This cutter driver would have been installed 
when configuring Vision 10 Software.
Periodically, Vision Software may release an updated cutter 
driver that supports improvements within the manufacturer 
device driver. The cutter driver may also have optimizations 
that are intended to improve the engraver performance.
Update your Vision 10 Software as follows:
1.	 From the Windows Start menu, go to the collection of Vision 

10 Software shortcuts that were provided, and choose 
Update Vision 10

2.	 After updates have completed, launch Vision 10 Software.
3.	 Choose File menu >> Install Cutter Devices
4.	 A wizard will guide you to indicate what cutter drivers 

should be available (this will update your drivers).
5.	 After installing your cutter drivers, choose Help menu >> 

Update License File to keep your license current.
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Appendix B
Hot Keys and Shortcuts

In This Section…
•	 Keyboard menu shortcuts
•	 Function keys
•	 Hot keys for aligning shapes
•	 Node palette
•	 The grid and align palette
•	 Node editing hot keys
•	 Color palette tips, and color substitutions
•	 Selecting and manipulating shapes

Keyboard Menu Shortcuts
Vision 10 Software menus have keyboard shortcuts that will 
reduce your editing time. These shortcuts are listed next to 
each menu item, and they can be customized via Options 
menu >> Customize Shortcuts

Function Keys
The function keys in Vision 10 Software operate as follows: 

[F1] Help
[F2] Disable all Shop Palette color layers 

except the current target layer
[F3] Select all objects
[F4] Refresh the workspace
[F5] Zoom marquee
[F6] Zoom out

[Shift+F6] Zoom in
[F7] Zoom to selected object
[F8] Zoom to Plate Size
[F9] Toggle between current and previous 

zoom levels
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Align Shapes to Last Selected Object
When using [Shift] to select a collection of objects, the 
following hot keys will align shapes to most recently selected 
object”

[L] Left – Align with the left edge of the last object.

[R] Right – Align with the right edge of the last object.

[T] Top – Align with the top edge of the last object.

[B] Bottom – Align with the bottom edge of the last object.

[E] Horizontally – Center horizontally along height of last 
object.

[C] Vertically – Center vertically along width of last object.

[F10] Select the menu bar

Align Selected Shapes
To align selected shapes quickly, use the following hot keys:

[ALT + 1] Align shapes along left edge of 
bounds

[ALT + 2] Center shapes vertically
[ALT + 3] Align shapes along right edge of 

bounds
[ALT + 4] Align shapes along top edge of 

bounds
[ALT + 5] Center shapes horizontally
[ALT + 6] Align shapes along bottom edge of 

bounds
[ALT + 7] Center shapes both horizontally and 

vertically

Align Shapes to the Plate Size
To align shapes to the plate size, use the following hot keys. 
Most of these correspond to Layout menu >> Arrange and 
Distribute >> Align to Plate.

[ALT + Delete] Left – Align with left edge of plate
[ALT + Page Down] Right – Align with right edge of plate

[ALT + Insert] Top – Align with top edge of plate
[ALT + Page Up] Bottom – Align with bottom of plate

<no default> Center – Align with center of the plate.

[ALT + End] Center Horizontally – Center horizontally along 
height of plate

[ALT + Home] Center Vertically – Center vertically along width 
of plate

[Ctrl + Q] Equal Spacing – Space text objects equally over 
height and width of plate.

<no default> Equal Vertical Spacing – Space text objects 
vertically across plate.

<no default> Equal Horizontal Spacing – Space text objects 
horizontally across plate.
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Polygon Editing Hot Keys
In addition to the Node Palette, the following keyboard hot 
keys are available when editing polygon objects:
(A) Add node – Create node at current cursor location.
(C) Change node – Cycle type of selected node. Type will 
cycle through Corner, Curve, and Tangent.
(R) Remove – Delete the selected node.
(L) Locate origin – Set grid origin to selected node.
(G) Grid dimensions – Set the grid size as the distance between 
the selected node and the grid origin.
(S) Snap to intersection – Move selected node to the nearest 
grid intersection.
(H) Snap to horizontal grid line – Move node to the nearest 
horizontal grid line.
(V) Snap to vertical grid line – Move node to the nearest 
vertical grid line.
(J) Join – Join two nodes with a connecting line.
(B) Break – Break contour at selected node.
[F3] – Select all nodes.
[ALT + F3] – Inverse selects all nodes.
(U) Alternate Select – Select every other node of currently 
selected nodes.
(D) Deselect – Clear the current node selection.
(O) Create perfect circle – Form nodes into a perfect circle.
(T) Toggle start point – Set the start point for routing or 
engraving this object.
(K) Click – Select the node under the mouse cursor.

Node Editing
When node editing a polygon or polyarc object, clicking the fill 
region of another object will switch node editing to the other 
shape. When node editing an object that overlaps another 
object, hold the [ALT] key to prevent the accidental selection 
of the underlying object.

The Node Palette
When editing a polygon or polyarc object, pressing the right-
mouse button will access the Node Palette, which provides 
commonly used tools for changing node type, joining and 
breaking nodes, and setting the start point and direction for 
routers and engravers.
Please note that since polyarc objects are composed only of 
curve nodes, the Node Palette will not allow you to change the 
node type for polyarcs (Fig. 122).

Fig. 122� - The Node Palette as it appears for polygon 
shapes (left), and polyarc shapes (right). Polygons 
can have Corner, Curve and Tangent nodes, 
whereas polyarcs use only Curve nodes.
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Bézier Editing Hot Keys
In addition to the Node Palette, the following keyboard hot 
keys are available when editing Bézier objects:
(A) Add node – Create node at current cursor location.
(B) Break – Break contour at selected node.
(C) Change node – Cycle type of selected node, though 
ignore node types that would change the curve (i.e., don’t use 
a corner node to represent a smooth curve).
(G) Grid dimensions – Set the grid size as the distance between 
the selected node and the grid origin.
(H) Snap to horizontal grid line – Move selected node to 
nearest horizontal grid line.
(I) Insert node – For two-or-more selected nodes, insert an 
intervening node.
(J) Join – Join two nodes with a connecting line.
(L) Locate origin – Set grid origin to selected node.
(R) Remove – Delete the selected node.
(S) Snap to intersection – Move selected node to the nearest 
grid intersection.
(U) Alternate Select – Select every other node of currently 
selected nodes.
(V) Snap to vertical grid line – Move selected node to nearest 
vertical grid line.

Polyarc Editing Hot Keys
In addition to the Node Palette, the following keyboard hot 
keys are available when editing polygon objects:
(A) Add node – Create node at current cursor location.
(R) Remove – Delete selected node.
(L) Locate origin – Set grid origin to selected node.
(G) Grid dimensions – Set the grid size as the distance between 
the selected node and the grid origin.
(S) Snap to intersection – Move selected node to nearest grid 
intersection.
(H) Snap to horizontal grid line – Move selected node to 
nearest horizontal grid line.
(V) Snap to vertical grid line – Move selected node to nearest 
vertical grid line.
(J) Join – Join two nodes with a connecting line.
(B) Break – Break contour at selected node.
[F3] – Select all nodes.
[ALT + F3] – Inverse selects all nodes.
(U) Alternate Select – Select every other node of currently 
selected nodes.
(T) Toggle start point – Set start point for routing or engraving 
this object.
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Selecting and Manipulating Shapes
To select a shape, click within the fill area of the shape. If Show 
Fills is off (under the View menu), then select the shape by 
clicking along its contour.
If the [ALT] key is used as a modifier key, then the shape will 
only become selected by clicking along its contour. This is a 
useful means of differentiating from between several clustered 
shapes.

Sweep Selecting Objects
A sweep select is simply a quick means of selecting several 
objects by surrounding the objects with a marquee. Modifier 
keys may also be used as follows:

Shift-sweep Select
•	 Add the objects to the current selection.

Control-sweep Select
•	 All objects that fall within bounds of the marquee will 

become selected. The current editing operation (if any) will 
be applied to the objects.

Alt-sweep Select
•	 For small objects that are within the area of a larger object, 

use [ALT] + marquee to select the small objects without 
selecting the larger object.

Color Palette Tips
When clicking a color in the Shop palette (or Job palette), 
additional tools are activated by pressing the [Shift], [Control], 
or [ALT] keys. The following table summarizes these modifiers:

•	 Left-click – Set fill color of current object
•	 Right-click – Set line style color of current object
•	 [Shift] + Left-click – Select all objects of that fill color
•	 [Control] + Left-click – Disable the color plate. All objects 

with that fill color will appear as dashed outlines.
•	 [ALT] + Left-click – Disable all color plates, except for the 

plate that was clicked

Job Palette Substitutions
In addition to listing colors, the Job Palette can be used 
to perform global search-and-replace of colors, primers, 
halftones, etc.

Set all red shapes to a blue fill color
1.	 Suppose that you have several red shapes
2.	 In the Job Palette, click [...] and choose Color View
3.	 Note that the red color appears in the Job Palette
4.	 From the Shop Palette, drag a blue color plate and drop it 

onto the red Job Palette color

Replace all shades of a spot color
1.	 Suppose that you have five shapes with different tints of a 

gold spot color, say 100%, 80%, 60%, 40%, and 20% tint
2.	 In the Job Palette, click [...] and choose Foil View
3.	 Note that the Job Palette lists the different shades of gold 

as a single color plate
4.	 From the Shop Palette, drag a green spot color and drop it 

onto the gold Job Palette color
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Symbols
3D Chisel Tool Path  200
3D Viewer  78

A
AccuScan  178
AccuScan and Image menu 

filters  179
Acquire Image  154
Aligning Shapes  210
Alignment  145
Align Palette  144
Align To Baseline  155
Anchor Nub  130
Array  146

B
Backup Engraving 

Parameters  69
Badges

Adding plate objects  111
Barcodes and serialization  

119
Create a plate design  97
Multiple badges per plate  

105
One badge per plate  100

Balance Colors  167
Barcodes  117
Baseline alignment  155
Basic Weld  128
Bevel Bitmap Effects  160
Bézier Hot Keys  215
Bitmap Creation  160
Bitmap Palette Colors  179
Bitmap Transformations  137
Blends using Metamorphosis  

133
Block Shadow  138

Index

Blower  67
Blur Filters  168

Noisy Blur  176

C
Cable Issues  42
Cast Shadow  138
Chisel Bitmap Effects  160
Clear Color  131
Clearing an Image 

Background  162
Clear Size/Move  130
Clip Art Viewer  152
Clipping and Clipping Clear  

136
Clipping an Image 

Background  162
CMYK  131, 159
Color Adjustments  166
Color Blends  132
Color Palette (default)  48
Color Palettes  124
Color Palette Substitutions  

216
Color Palette Tips  216
Color Types  131
COMM Output Port  42
Contour Cut  92
Contour Cut (images)  94
Contour Fill Tool  90
Contrast/Brightness  166
Converting bitmaps into line 

art  181
Convert to Curves  155
CorelDraw Files  85
Corner Power  67
Curves Dialog  166
Customizing Keyboard 

Shortcuts  209
Cut Colors  60
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Cutter Drivers (in Production 
Spooler)  189

Cutting Interlocking Parts  71

D
Decorative Border  140
Decorative Border Clip-Art  

140
Devices menu  194
Digitizing Tablets  155
Dongle  22
Drill Center  200
Drill Contour  200
Drill Point  200
Drop Shadow  138

E
Easy Color Adjustments  166
Engraver Options  40
Engraving Defaults  30, 54
Engraving Fill Colors  64
Exporting Files  153

F
Female Tool Path  199
File Output Port  42
Fill and Stroke Colors  50
Fill Colors  131
Fill Tool Path  199
Filter By Color  203
Filters  168
Fit Text to Arc  127
Fit Text to Frame  127
Fit Text to Path  127
Flip  130
Fluid Mask  162
Foil Colors  131
Font Height  27
Function Keys  209
Fuse Weld  82

G
Grade Width  68
Gradient Fill  132
Graphic Edit Tools  125
Grid lines  144
Groups of shapes  135
Group Viewer  136
Guidelines  143

H
Halftone Filter  169
Harry’s Filters (Plug-ins)  173
Histo Contrast  167
Histo Equalize  167
Hog Tool Path  199
Hole in Center  68
Hole Interval  68
Hue/Saturation  166

I
Illustrator Files  85
Image Background 

(Deleting)  162
Image Cut  184
Image Menu

Color Adjustments  166
Filters  168
Plug-In Filters  170

Image Size  161
Image Transformations  137
Image Type (Mode)  159
Importing Files  85, 151
Inline  137
Installation Checklist  18
InstantReplay  26, 130
Invert  167
Invisible Color  131
Invisible Color Blend  133
Iron filings  184

J
Job Colors Dialog  54, 60

Job Palette Substitutions  216
Jobs menu  193
Jogging  202

K
Keyboard Shortcuts  209
KnockMeBlackOut  172
KnockMeColorOut  172

L
LAB  131
Lasso Selection  129
Layer Viewer  25, 135
Levels Tool  166
License Files  22
License File Updates  207
Line/Fill Button  131
Line Fonts  83
Line Style  131

Show Tool Diameter  123
Log Tab  196
LPT Output Port  42

M
Machine Limits  36, 58
Make Path  81
Male Tool Path  198
Manage Queues  193
Material Setting  65, 67
Merge Colors  180
Metamorphosis  133, 137
Min Power  68
Mirror  130
Miter Limit  92, 139
Mode  66, 70
Monochrome Filter  95
Move  130
Multiple Instance  26

N
Nested Engraving Shapes  81
Nesting  148

Node Editing  212
Node Edit Tools  125
Node Palette  212
Noise Filters  168, 176
Nubs  130
Nudge  130

O
Online Tool Path  198
Order To Front  135
Origin  28
Origin and End Point  36
Outline  137
Output Area Examples  73
Output Port Types  42
Output Preview  78
Output Tool Paths  184
Output Tool Usage  204
Overlapping Shapes  81

P
Parallel Output Port  42
Passes  67
Pattern Fill  132
Perspective Shadow  138
Photo Laser  114
PhotoMachine  184
Plate Objects  111
Plate Size  28, 123
Plotter Jog  202
Plug-in Filters  170

Vision Software Effects  172
Harry’s Filters  173
Mehdi  177
Production Plug-ins  172

Point Size  27
Polyarc Hot Keys  214
Polygon Hot Keys  213
Port Configuration  38, 58
Port Types  42
Posterize

Color Adjustments  167
Posterize Filter  172
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Text to Graphics  136
Tile Settings  202
Toolbar (Production Spooler)  

192
Tool Options  34, 56
Tool Path Creation  44
Tool Paths  197
Tool Tracking  204
Tool Usage  204
Tracing Artwork  87
Tracing Images

Prepare to Vectorize Wizard  
182

Transformation  137
Transparency

Transparency Fill  132
Transparency Opacity plug-

in  172
Transparent Bitmap Color  

160, 179
Traveled Distance  77

U
Underline  127
Undo Setup  157
Ungroup  135
Unsharp Mask  168
Updates  207
USB Output Port  42
USB Port Issues (dongle)  22

V
Variable Text  102, 107
Vectorization of Images

Prepare to Vectorize Wizard  
182

View Files  58

Posterize Region 
(AccuScan)  180

Power  66
Power Weed  205
Prepare to Vectorize Wizard  

182
Process Color  131
Production Spooler  185
Production Spooler Layout  

191
Production Spooler Setup  38

Q
Queue Menu  193
Queue Properties  188, 195
Queue Tab  186

R
Radiation Time  68
Rain  184
Registration Marks  201
Relief Shadow  138
Remove Red Eye  169
Render Contour Bitmap  160
Rendering Bitmaps  160
Reset Origin  144
Resizing Images  161
Rotary Engraving  197
Rotate  130
Round Corners  140
Rulers  27

S
Saving Job Color Parameters  

66
Scan Gap  68
Scanning Artwork  154
Scratch Disk  158
Security Device  22
Selecting and Manipulating 

Shapes  217
Selecting Shapes  129

Send To plug-ins  85
Sequence  146
Serial Output Port  42
Shadow  138, 173
Shape Creation  125
Sharpen Filters  168
Sheet Page Palette  29, 124
Shop Palette  124
Show Bitmap Outlines  25
Show Fill  25
Show Plate  25
Show Tool Diameter  25
Show Tool Paths  25
Show Traveled Distance  77, 

204
Size  130
Slant  130
Slice Tools  126
SmartBar  124
Snap Angle  130
Software Updates  207
Speed  66
Speed units  27
Spell Check  127
Spot Color  131
Spot Foil  131
Squares  184
Stars  184
Start Sequence  146
Stencils  140
Stretch Intensity  167
Stroke Color  131
Strokes  131

Show Line Style  123
Stylize / Artistic filters  169
Super Size Image  161
Swap Colors  167
Sweep Selecting Objects  217

T
TCP/IP Output Port  42
Text Creation  127
Text Substitution  103, 108

W
Weed Border  205
Weld Tools  136
Wiggle  184
Workspace Settings  123
Wrong Mode Setting  70


